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Safety Notices

CAUTION
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or loss of important data. Do not pro-
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understood and met. 

WARNING
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It calls attention to an operating pro-
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WARNING notice until the indicated 
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Safety Summary
The following general safety precautions must be observed during all phases of operation of this 
instrument. Failure to comply with these precautions or with specific warnings or operating 
instructions in the product manuals violates safety standards of design, manufacture, and intended 
use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply 
with these requirements. Product manuals are provided with your instrument on CD-ROM and/or in 
printed form. Printed manuals are an option for many products. Manuals may also be available on 
the Web. Go to www.keysight.com and type in your product number in the Search field at the top of 
the page.

General Do not use this product in any manner not specified by the manufacturer. The protective features of 
this product may be impaired if it is used in a manner not specified in the operation instructions.

Before Applying
Power

Verify that all safety precautions are taken. Make all connections to the unit before applying power. 
Note the instrument's external markings described in “Safety Symbols”.

Ground the
Instrument

If your product is provided with a grounding type power plug, the instrument chassis and cover must 
be connected to an electrical ground to minimize shock hazard. The ground pin must be firmly 
connected to an electrical ground (safety ground) terminal at the power outlet. Any interruption of 
the protective (grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Fuses See the user's guide or operator's manual for information about line-fuse replacement. Some 
instruments contain an internal fuse, which is not user accessible.

Do Not Operate in
an Explosive
Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Only qualified, service-trained personnel who are aware of the hazards involved should remove 
instrument covers. Always disconnect the power cable and any external circuits before removing the 
instrument cover.

Cleaning Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not use 
detergent or chemical solvents.

Do Not Modify the
Instrument

Do not install substitute parts or perform any unauthorized modification to the product. Return the 
product to a Keysight Sales and Service Office for service and repair to ensure that safety features 
are maintained.

In Case of Damage Instruments that appear damaged or defective should be made inoperative and secured against 
unintended operation until they can be repaired by qualified service personnel.

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, 
or the like that, if not correctly performed or adhered to, could result in damage to the 
product or loss of important data. Do not proceed beyond a CAUTION notice until the 
indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, 
practice, or the l ike that, if not correctly performed or adhered to, could resul t in 
personal injury or death. Do not proceed beyond a WARNING notice until the ind icated 
cond itions are fully understood and met.

www.keysight.com
www.keysight.com
www.keysight.com
www.keysight.com
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Safety Symbols

Table 1  Safety Symbol

Symbol Description

Direct current

Alternating current

Both direct and alternating current

Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

N Neutral conductor on permanently 
installed equipment

L Line conductor on permanently installed 
equipment

On (mains supply)

Off (mains supply)

Standby (mains supply). The instrument is 
not completely disconnected from the 
mains supply when the power switch is in 
the standby position

In position of a bi-stable push switch

Out position of a bi-stable push switch
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Equipment protected throughout by 
DOUBLE INSULATION or REINFORCED 
INSULATION

Caution, refer to accompanying 
documentation

Caution, risk of electric shock

Do not apply around or remove from 
HAZARDOUS LIVE conductors

Application around and removal from 
HAZARDOUS LIVE conductors is 
permitted

Caution, hot surface

Ionizing radiation

CAT I IEC Measurement Category I

CAT II Measurement Category II

CAT III Measurement Category III

CAT IV Measurement Category IV

Symbol Description
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Compliance and Environmental Information

Table 2  Compliance and Environmental Information

Table 3  Environmental Information

Safety Symbol Description

CSA is the Canadian certification mark to demonstrate compliance with the Safety 
requirements.

The C-tick mark is a registered trademark of the Spectrum Management
Agency of Australia. This signifies compliance with the Australia EMC
Framework regulations under the terms of the Radio Communication Act
of 1992.

CE compliance marking to the EU Safety and EMC Directives.
ISM GRP-1A classification according to the international EMC standard.
ICES/NMB-001 compliance marking to the Canadian EMC standard.

KC certification mark to demonstrate compliance with the South Korean EMC 
requirements.
South Korean Class A EMC declaration
This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.

Safety Symbols Description

This product complies with the WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the requirement types in the WEEE Directive 
Annex I, this product is classed as a “Monitoring and Control Instrumentation” 
product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see 
www.keysight.com/environment/product/ for more information.

www.keysight.com/environment/product/
www.keysight.com/environment/product/
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1 Introduction

The U4431A MIPI M-PHY Analyzer module is an acquisition module that captures and decodes data 
as per MIPI M-PHY standards including UniPro, UFS, SSIC, MPCIe, and CSI-3. Using this module, 
you can get insight into the M-PHY protocol stack. 

It allows you to test and troubleshoot the data link, network, transport, and application layers of the 
M-PHY protocol stack.

You can use multiple U4431A modules in a chassis to test and debug multi-bus systems. You can 
also time-correlate M-PHY busses with MIPI D-PHY CSI-2 and DSI-1, PCIe, DDR and HDMI busses 
by using multiple Keysight AXIe based modules in a time-correlated setup.

For the display and analysis of the captured data, the U4431A module presents the data in a Protocol 
Viewer, Waveform Viewer, and a Listing Data View.

This module needs to be installed in a Keysight AXIe chassis (for example, the M9502A 2 slot 
chassis). When a controller PC is connected to the AXIe chassis via an external PCIe / USB interface 
and a cable, the Keysight Logic and Protocol Analyzer application (running on the controller PC) lets 
you configure, control, and use the U4431A module. 
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Protocols Supported

The U4431A module currently supports capture and decode for the following protocols:

• M-PHY 2.0 

• Unified Protocol (UniPro) 1.41.00 and 1.6 

• Universal Flash Storage (UFS) v1.1 

• SSIC 

• CSI-3 

• MPCIe

By default, the base protocol supported on the U4431A module is M-PHY. As and when needed, you 
can add other supported protocol capabilities to your U4431A module by purchasing and installing 
appropriate U4431A licenses. Refer to the U4431A module data sheet (part number 
5991-2544EN.pdf) available at www.keysight.com/find/mphy_analyzer to know about various 
licensed options available for the module.

NOTE
You can view which licenses are currently active/in use on your U4431A module and which 
licensed options are installed/available for use. For this, you can use the Keysight Notification 
Center  icon. This icon is displayed as a green dot on the taskbar (lower, right-hand corner 
of your desktop) if the Keysight Logic and Protocol Analyzer GUI is installed. If the GUI is open 
and running, the Notification Center icon changes to .

1. Right-click the Notification Center icon and select Show Instrument Details from the 
displayed menu.

2. In the Instrument Details dialog box, expand the Module: U4431A Protocol Analyzer node.

3. Note the currently active and available licensed options.

www.keysight.com/find/mphy_analyzer
www.agilent.com/find/mphy_analyzer
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Introduction 1

U4431A Features

A U4431A module:

• Can acquire protocol level data as well as raw signal level data.

• Provides upto 16 GB of memory that you can divide and allocate for capturing raw signal level 
and protocol level data.

• Supports preempting of UniPro data.

• Supports noise filtering for PWM gears.

• Syncs up to the DUT's link configurations based on the settings that you define. 

• Can track DUT's link configurations automatically.

• Supports descrambling of scrambled data for SSIC data acquisition.

• Provides a number of viewers to view the acquired data. 

• Allows you to set the following attributes independently for the Transmit and Receive sublinks.

• Link width 

• x1, x2, x3 and x4 for UniPro/UFS/CSI-3

• x1, x2, and x4 for SSIC (Same link width is applicable for both sublinks in case of SSIC.)

• x1, x2, and x4 for MPCIe

• Burst mode - PWM or HS Gear per sublink. 

• PWM Gear 1 to 7 and HS Gear 1, 2, and 3 for UniPro/UFS/CSI-3

• PWM Gear 1 and HS Gear 1, 2, and 3 for SSIC and MPCIe

• Sublink based enabling and disabling of raw signal level and protocol level (UniPro, CSI-3, SSIC, 
MPCIe, and UFS) data capture.

• Sublink based division and allocation of memory between raw and protocol level data acquisition.

• Allows you to set the following attributes at the link level (applicable for both sublinks of the link). 

• Data rate series applicable for the link in the High Speed (HS-Mode). 

• Link Synchronization

• HS Gear profile (only for SSIC). Same HS Gear is used for both sublinks in case of bidirectional 
link configuration.

• Link width profile (applicable for SSIC and MPCIe). Same link width is used for both sublinks in 
case of bidirectional link configuration.

• PWM Filtering (for UniPro)



1 Introduction

14 Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide

Related Documents

Besides using this U4431A User Guide, you can also access the following documents that provide 
related information about the U4431A module.

• MIPI M-PHY Protocol Analyzer Hard ware and Probing Guide - This guide provides information 
on the acquisition probing options available for use with the U4431A module. This guide is 
available on www.keysight.com/find/mphy_analyzer and is also installed with the Logic and 
Protocol Analyzer software at <logic Analyzer Install location>\help\pdfs. It describes how to 
make probing connections from the DUT to the Keysight U4431A module for various probing 
situations.

• AXIe Based Logic Analysis and Protocol Test Modules Installation Guide - This guide provides 
information on the Keysight AXIe chassis, the U4431A module, how to set up the chassis, module, 
and host computer and how to obtain and install the associated software components. This guide 
is available on www.keysight.com/find/mphy_analyzer and is also installed with the Logic and 
Protocol Analyzer software at <logic Analyzer Install location>\help\pdfs.

• MIPI M-PHY Protocol Analyzer and Exerciser Online Help - This online help describes how to 
configure and use the U4431A module to capture M-PHY data. This online help is integrated with 
the Logic and Protocol Analyzer software and is accessible from its Help menu.

• Context-sensitive help - A context-sensitive HTML help page is available with each window and 
dialog box of the U4431A module on clicking the Help button displayed within the GUI element.

www.keysight.com/find/mphy_analyzer
www.keysight.com/find/mphy_analyzer
www.keysight.com/find/mphy_analyzer
www.keysight.com/find/mphy_analyzer
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2 Configuring U4431A 
Connection Settings

By default, you can set up a single direction (Tx or Rx) link between the U4431A module and DUT for 
data capture. If you have the Bidirectional (Tx and Rx) license installed, you can set up a dual-simplex 
link for capturing Tx as well as Rx data. The module allows you to use one or more unidirectional 
lanes for each direction. You can choose different number of lanes and lane properties for each 
direction except in case of an SSIC setup in which same link width is used for both sublinks.

You set up this link by configuring the module's connection setup in the Keysight Logic and Protocol 
Analyzer application after completing the hardware setup for the U4431A module in the AXIe chassis 
and connecting it to the DUT using appropriate probing hardware. You use the Connection Setup tab 
of the U4431A module's Setup dialog to configure its connection setup.

The connection setup details that you specify in this tab tells the Logic and Protocol Analyzer 
software how the U4431A module is connected to the DUT for data capture. 
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To configure U4431A connection setup

1 In the Logic and Protocol Analyzer GUI, access the Setup dialog box of the U4431A module by 
clicking Setup > Setup from the GUI’s menubar.

The Connection Setup tab is displayed in the Setup dialog box.

2 Configure connection settings in this tab. The tab has the following fields. 

Field Description

Module - This group box displays read-only and editable fields for the U4431A module hardware.

Chassis Read-only field that displays the AXIe chassis number in which you installed the U4431A hardware module.

Slot Read-only field that displays the slot number of the AXIe chassis in which you installed the U4431A hardware module.

Link Displays the type of link between the U4431A module and DUT based on the protocol family that you selected at the time of 
starting up the Logic and Protocol Analyzer GUI session. 

Link Mode Currently, U4431A supports the following connection mode.
• Analyzer - In this mode, the U4431A module can only be used as an analyzer to passively probe and acquire data from 

DUTs. This mode doesn’t allow the usage of the U4431A module as an Exerciser to stimulate the DUT. In this mode, 
U4431A can acquire both protocol level and raw signal level data simultaneously. 

Connection Allows you to select the type of connection you want to set up between the U4431A module and DUT for data capture. The 
following two connection options are available.
• One Sublink - This is the default option. It allows you to set up a single unidirectional link (Tx or Rx) between the 

U4431A module and DUT.
• Both Subl inks - This is a licensed option. It allows you to set up a bidirectional link (Tx as well as Rx) between the 

U4431A module and DUT. When you select this option, you get options in the Link Naming and Lane Setup section to 
set up a Tx and an Rx sublink independently of each other. 

License Displays the type of U4431A license(s) currently installed on the system.

Link Naming and Lane Setup 

Name Displays the name of the M-PHY link that you set up. For a bidirectional link, the names of both Tx and Rx sublinks are 
displayed. 
If needed, you can rename these links. 

Pods The U4431A module has two pods labeled as Pod 1 and Pod 2 on its front panel. These pods are used to connect the 
module to the DUT using probe cables. 
For a single sublink (Tx or Rx), Pod 1 is used and displayed in this field.
For Both sublinks (Tx and Rx), Pod 1 and Pod 2 are used (one for each direction).
Ensure that you set up the probing hardware configuration appropriately matching the pod used and displayed for the link.

Sublink Width Select the maximum link width capability that you want to define for the sublink (Tx or Rx). For instance, if you select x4 in 
this listbox, then you can set x1 to x4 as the initial or current link width of this sublink in the Analyzer Setup tab. This listbox 
provides options to select a link width from x1 to x4 individually for each sublink. However, some of the options in this 
listbox are not available if you do not have the appropriate link width license installed. By default, only x1 is available as the 
link width. Other options are licensed. 
NOTES
- Ensure that you make appropriate hardware and probing setup for the U4431A module to match the link width capability 
you want to set in the Sublink Width field.
- For a bidirectional SSIC setup, the same link width is applicable for both sublinks.

Probe Type Detects and displays the probing option that you have used in the U4431A hardware setup to probe the DUT.
The following probing options are available for use with the U4431A module:
• U4433A Differential ZIF Flying Lead probe
• U4432A SMA probe 
For detailed information on probing, refer to the U4431A MIPI M-PHY Analyzer - Hardware and Probing Guide. The guide is 
available on www.keysight.com/find/mphy_analyzer and also installed with the Keysight Logic and Protocol 
Analyzer software.

www.keysight.com/find/mphy_analyzer
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Lane Order The Lane Order option lets you perform the ordering of the physical probe channels of the U4431A module with the logical 
data lanes probed by each of these channels. You can either retain the Default lane ordering which means channel 0 of the 
module maps to logical lane 0 and so on. If you want to change this default mapping of channels with logical lanes, then 
select the Custom option from Lane Order and click Specify to display the Custom Lane Ordering dialog box. In this dialog 
box, select the module’s channel with which you want to map a target logical lane. 
You can also set the polarity inversion property for each data lane using the Custom Lane Ordering dialog box. The polarity 
of a data lane is not inverted when the positive and negative sides of the probe channel’s differential pair are connected to 
the positive and negative sides of the signal in the DUT. 

State Activity Displays the current status of the four data lanes LEDs located on the front panel of the U4431A module. The following 
color coding is used for these LEDs to indicate the state activity on the associated lanes.
• Red - This means that the lane is in the ultra-low power state (HIBERN8) without loss of configuration information. 
• Blinking Red - This means that the lane state is unknown. This can happen when the U4431A module is in the process 

of syncing up to the current link configurations. 
• Green - This means that the lane is transmitting HS-BURST in HS-MODE.
• Blinking Green - This means that the lane is in the STALL state - the power saving state (periods of inactivity) when 

operating in HS-MODE.
• Yellow - This means that the lane is transmitting LS-BURST in Low Speed-MODE.
• Blinking Yellow - This means that the lane is in the SLEEP state - the power saving state (periods of inactivity) when 

operating in Low Speed-MODE.
• Off - This means that the lane is not configured/available. Based on the link width that you select in the U4431 

Connection Setup tab of the Logic and Protocol Analyzer GUI, the number of lanes on the U4431A module are used. The 
LEDs of only the used lanes glow. For example, if you are using the x2 link width, then the LEDs of only two lanes being 
used will glow and the rest of the LEDs will be off.

You can also refer to the LED Color Legend section at the bottom of the tab to know what each LED color represents.

LED Color Legend This section displays a description for various colors of the data lanes status LEDs on the front panel of the U4431A 
module. Each LED color represents a specific state activity on the associated lane. Refer to the State Activity field 
description in this table to know more about the state activity on lanes.

Field Description
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3 Switching M-PHY Protocols

If you have a single (Unipro, Unipro+UFS, Unipro+CSI-3, or SSIC) protocol license for the U4431A 
module, then by default, the Logic and Protocol Analyzer GUI is started using that licensed protocol 
option when you launch this GUI.  

If you have purchased multiple protocol licenses for the U4431A module, then the Logic and Protocol 
Analyzer GUI is started using the currently selected protocol option. In situations when multiple 
protocol licenses are available, you can choose the protocol license option with which you want to 
launch the Logic and Protocol Analyzer GUI. This feature allows you to switch among the Unipro, 
Unipro+UFS, Unipro+CSI-3, MPCIe, and SSIC analysis when using the U4431A module with these 
multiple protocol license options. 

You use the U4421A-U4431A-Protocol-Selector.bat script to select Unipro, Unipro+UFS, 
Unipro+CSI-3, MPCIe or SSIC protocol when accessing the Logic and Protocol Analyzer GUI.

To select M-Phy protocols (Unipro, UFS, CSI-3, MPCIe or SSIC)

1 Double-click the U4421A-U4431A-Protocol-Selector.bat script to launch it. The script is installed 
at the following location when you install the Keysight Logic and Protocol Analyzer software 
(version 5.80.0000 or later).

C:\Program Files (x86)\Keysight Technologies\Logic Analyzer\Contributed Files (for 64 bit OS 
installs)

or 

C:\Program Files\Keysight Technologies\Logic Analyzer\Contributed Files (for 32 bit OS installs)

2 The script starts running in the Command window with warning messages displayed. Press any 
key to continue.

NOTE
The U4421A-U4431A-Protocol-Selector.bat script puts any active Logic and 
Protocol Analyzer GUI sessions to the offline mode during protocol change. 
Therefore, you must stop any ongoing analysis work and save your captured 
data/configurations before you start using this script.



3 Switching M-PHY Protocols

20 Keysight U4431 MIPI M-PHY Protocol Analyzer User Guide

3 Specify the slot number in which you installed the U4431A module for which you want to select 
the protocol. Press <Enter>.

4 Specify the MIPI protocol that you want to select for the module. Specify M-phy Unipro to select 
the Unipro protocol, M-phy Unipro UFS to select the Unipro+UFS protocol, M-phy Unipro CSI-3 
to select the Unipro+CSI-3 protocol, and M-phy SSIC to select the SSIC protocol. Press <Enter>.

NOTE
If an invalid slot is used or an input other than the number 1 to 5 is entered (for 
example- any string), the script will run as usual, but the background operation 
that the script performs will not succeed.  The script will crash in case a string 
with a space is entered.

NOTE
UFS and CSI-3 protocol licenses are available in combination with the Unipro 
license.
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Switching M-PHY Protocols 3

5 The User Account Control dialog box is displayed. Click Yes to proceed.

NOTE
The CSI and DSI options are available for the U4421A MIPI D-PHY module and these options 
will be ignored for the U4431A module.
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The script runs to perform the protocol change as per your selections. The protocol change is 
successfully completed if you have specified the correct slot number for the U4431A module and 
appropriate license is available for the selected protocol.

If an invalid option is entered (other than the number 1 to 7), the script fails to execute and keeps 
on prompting until a valid choice is made. 
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6 When the protocol change completes, you need to bring any open offline sessions of the Logic 
and Protocol Analyzer GUI to the Online mode by clicking File > Go online to Local Host option in 
the GUI's menubar. If there are no existing open sessions of the GUI, launch the GUI in the Online 
mode.

The Logic and Protocol Analyzer GUI should now launch with the selected protocol.

To verify if protocol change is successful

• Using the agNotificationCenter icon 

1 Double-click the agNotificationCenter icon displayed in Window's taskbar. 

2 In the Instrument Details dialog box, expand the U4431A module option for which you changed 
the protocol.

The protocol currently selected for the module is displayed.

• Using the Logic and Protocol Analyzer GUI

1 Launch the Logic and Protocol Analyzer GUI in the Online mode. 

2 Click Setup > Setup from the GUI’s menubar to access the Setup dialog box of the U4431A 
module for which you changed the protocol.

3 In the Connection Setup tab, the currently selected protocol (Unipro, UFS, CSI-3, MPCIe or 
SSIC) for the module is displayed.
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This chapter provides information on how to configure the U4431A module as an analyzer to capture 
M-PHY data.
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Before you Start

Before you start capturing data, ensure that the following tasks are performed.

• You have connected the U4431A module to the DUT using the appropriate acquisition probe in 
the required configurations.

• You have installed the Keysight Logic and Protocol Analyzer GUI, version 5.80.0000 or higher.

• You have configured the U4431A module’s connection setup in the Keysight Logic and Protocol 
Analyzer GUI. 

• You have specified the sync related settings in the Analyzer Setup tab. The U4431A module uses 
these settings to sync up to the DUT's link configurations before data capture. 
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Supported Acquisition Probes

The following acquisition probes are supported for the U4431A module.

• U4433A Differential ZIF Flying Lead probe - Can probe individual signals from multiple randomly 
located points on the target system. 

• U4432A SMA probe - Provides coaxial SMA connections for each of the lines of the M-PHY bus.

For detailed probing information and how to make connections with the U4431A module and DUT, 
refer to the U4431A MIPI M-PHY Analyzer Hardware and Probing Guide. The guide is available on 
www.keysight.com/find/mphy_analyzer and also installed with the Keysight Logic and Protocol 
Analyzer software. 

http://www.keysight.com/find/mphy_analyzer
www.agilent.com/find/dphy_analyzer
www.keysight.com/find/mphy_analyzer
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Configuring Data Capture and Sync Settings

You can configure the data capture settings at the link and sublink(s) levels using the Analyzer Setup 
tab in the Setup dialog box of the Logic And Protocol Analyzer GUI.

The U4431A module performs the sync process before it starts data capture to sync up to the DUT’s 
link configurations such as link width, burst mode, link speed, and HS rate series. To enable the 
U4431A module to perform this sync process, you define link/sublink settings that the module 
should use during this sync process and also instruct the U4431A module on how it should perform 
this sync process. You use the Analyzer Setup tab to define these settings.

NOTE
The U4431A module does not start capturing data until it completes the sync process.
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The following screen displays the capture settings fields available for a bidirectional UniPro/UFS 
setup.

The Analyzer Setup tab has the following fields that you can modify to configure the capture and sync 
related settings.

Some fields are license-specific and are displayed only when an appropriate U4431A license is 
installed.
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Field Description

Link Setup

Enable Preemption Support
(Applicable only for a UniPro setup)

Allows you to enable or disable the preemption support for the link. The preemption support is based on the UniPro 
specifications. Therefore, this option is applicable and visible only when you install the UniPro specific license on the 
system. 
When this support is enabled, the U4431A module identifies and supports preemption in the captured data, for instance, 
preemption for higher priority frames into lower priority data frames. For preemption, U4431A supports the nesting limited 
to level 1. 
With preemption enabled, you can view the preempted frames in the captured trace displayed in the Protocol Viewer.

Data on link is scrambled
(Applicable for SSIC and MPCIe setup)

Allows you to instruct the U4431A module on whether or not the data on the link is scrambled. Depending on the protocol 
license that is either SSIC or MPCIe whichever is currently applicable, the scrambling is based on the SSIC or MPCIe 
specifications. Therefore, this option is applicable and visible only when you install the SSIC or MPCIe specific license on 
the system.
If you select this checkbox, the U4431A module expect scrambled data on the link and enables descrambling of the 
scrambled data. 
If you do not select this checkbox, the U4431A module does not expect scrambled data and therefore descrambling is not 
enabled and the data is presented as is. 
You can view the descrambled data in the captured trace using the Waveform Viewer. 
To know how to view scrambled data, refer to the topic “Viewing Deskewed and Descrambled Data" on 
page 66. 

PWM Filtering Level Allows you to instruct the U4431A module on whether or not it should implement the noise filtering when capturing PWM 
signals which are more prone to noise. This listbox also allows you to set the amount of noise filtering to be applied for 
PWM gears based on the actual bit rate being transmitted by the DUT. You can select from the following filtering options. 
• No Fil tering - This option means that there is no noise filtering applied for PWM gears. 
• All Data Rates - This option means that the U4431A module applies the maximum possible filtering even when the DUT 

is transmitting at the maximum data rate from the data rate range defined for all PWM gears. This is the default setting 
and is suitable for most of the situations. 

• Rates < = 75% Max - This option means that the U4431A module applies more filtering than applicable for the All Data 
Rates option. However, for this option, the DUT should transmit at less than or equal to 75% of the maximum data rate 
from the data rate range defined for all PWM gears. 

• Rates < = 25% Max - This option means that the U4431A module applies more filtering than applicable for the Rates < 
= 75% Max option. However, for this option, the DUT should transmit at less than or equal to 25% of the maximum data 
rate from the data rate range defined for all PWM gears. 

NOTE: 
PWM Filtering is applicable only to lane 0 of each sublink. The U4431A module does not perform PWM filtering for lanes 
1-3. Therefore, to ensure that you get good data in case of multilane PWM configurations, enable terminations on the link 
when the link is in the PWM mode. This can usually be done by issuing a power mode request.

HS Profile
(Applicable only for an SSIC setup)

This option is displayed only when you install the SSIC license for the U4431A module. The option is enabled only when 
you select the Track Link Configuration Automatically option in this tab. 
The HS Profile option has the following two components:
• Gear - Allows you to set the HS Gear profile for the U4431A module. This setting is applicable for both sublinks in case 

of a bidirectional link configuration. The U4431A module can dynamically change to this profile in response to the 
changes in the probed link's configurations. For instance, you can set the initial burst mode as PWM Gear 1 in the Initial 
or current burst mode listbox and set the HS Profile to HS Gear 2. This will ensure that initially, PWM Gear 1 is used as 
the burst mode and then later HS Gear 2 is used in response to the probed link's configuration changes.

• Wid th - This is a read-only field that displays the link width that you configured for the U4431A module in the 
Connection Setup tab. This link width profile is applicable for both sublinks in case of a bidirectional link configuration. 

UniPro Spec Version
(Applicable only for a UniPro setup)

Allows you to select the version of the UniPro specifications based on which you want the U4431A module to decode and 
present the captured data. For instance, if you select the 1.6 version, you get an option to instruct the U4431A module on 
whether or not the data on a sublink is scrambled. 
The listbox is visible only when you install the UniPro specific license. 
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Link Configuration

HS Rate Select the data rate series at which you want the U4431A module to capture data in the High Speed (HS-Mode). The 
selected rate series is applicable for both sublinks in the HS-Mode. 
As per the M-PHY specifications, the following two Data Rate series are available for selection:
• A-Series 
• B-Series 
The data rate applicable for various gears in these series is as per the data rate defined in the M-PHY specifications. 

Link Configuration Tracking Allows you to configure how you want to the U4431A module to track and act for the changes in the probed link 
configurations such as link speed and link width. 
• Track Link Configuration Automatically - Select this option to ensure that the U4431A module automatically tracks the 

probed link’s configuration changes such as changes in sublink speed and width. On enabling this option, the U4431A 
module automatically changes its link configurations in response to the changes in the probed link’s configurations. 
Such automatic tracking and adjustments in link configurations are then viewable in the data captured and displayed in 
the Protocol Viewer. 

• Lock Analyzer at Specified Link Configuration - Select this option to ensure that the link configurations such as sublink 
speed and sublink width of the U4431A module are fixed to the values that you currently selected in the Sublink Setup 
group box. On selecting this option, the U4431A module does not change its link configurations automatically in 
response to the changes in the probed link’s configurations. When locked to a specific configuration, the U4431A 
module will capture data specific to only that configuration.

Sync on exit from hibern8 or power off Select this checkbox to instruct the U4431A module to sync up to the DUT configurations on DUT’s exit from the hibern8 or 
power off state. 
This option is disabled and therefore fixed if you select the Lock Analyzer at Specified Link Configuration option. This option 
is enabled only when you have instructed the U4431A module to track and respond to the changes in the probed link 
configurations automatically. 
Selecting this checkbox is particularly useful when the U4431A module is in the process of syncing to the DUT’s 
configurations and you want to convey the hibern8 or power off state of DUT to the U4431A module. When you select this 
checkbox, the U4431A module gets to know about the hibern8 or powered off state of DUT and then consequently starts 
ignoring all data from the DUT until it detects the DUT’s exit from HIBERN8. 
To ensure that the dynamic changes to this checkbox take effect, you also need to click the Sync Analyzer to Link 
Configuration button after selecting/deselecting this checkbox. 
NOTE: When the U4431A module completes its sync process, it can automatically track the DUT’s entry and exit from 
hibern8.

Direction to monitor for configuration 
tracking

This option is available only when you have chosen to analyze both Tx and Rx sublinks (Both Sublinks option in the 
Connection Setup tab).
This option allows you to select the sublink that you want the U4431A module to monitor for tracking the link configuration 
requests. 

Sublink setup 

Raw Data Capture - The U4431A module can capture both protocol level and raw signal level data simultaneously. The raw data capture allows you to view the 
time-correlated 8b/10b data or 8b Deskewed data that underlies a protocol. This data can be displayed in the Waveform or Listing viewer, providing insight into how 
a packet is formed at the physical layer.
The Raw Data Capture group box contains the following fields to enable and set the raw data capture setting for a sublink.

Raw Data You can choose to enable or disable the raw signal level data capture for the applicable sublink. 
You can instruct the U4431A module to capture the raw signal level data by selecting the Enable checkbox displayed with 
the Raw Data field. 

Depth You can divide the total memory depth that is licensed and available for the U4431A module between the configured 
sublink(s) of the link. For each sublink, you further divide the allocated memory between the protocol level data acquisition 
and raw signal level data acquisition (if enabled). 
From the Depth listbox, select the memory depth that you want to allocate to the acquisition of the raw signal level data for 
the sublink. This listbox is disabled if you deselect the Enable checkbox displayed with the Raw Data field. 
You can allocate a value ranging from 64 KB to 4 GB as the raw data capture memory depth.

Field Description
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Mode Select the mode of raw signal level data acquisition. You can select from the following three options:
• 8b Data - Select this option if you want to display 8b symbol data. Data will not be deskewed in this case. 
• 10b data - Select this option if you want to display 10b raw data. Data will not be deskewed/descrambled in this case. 
• 8b Deskewed Data - Select this option if you want the acquired data to be deskewed and aligned across lanes. 
• 8B Descrambled and Deskewed Data - This option is applicable for SSIC and MPCIe setup. Select this option if you are 

expecting scrambled data on the sublink and want the U4431A module to descramble and deskew the acquired data. 
On selecting this option, the module will, however, descramble the acquired data only if the Data on link is scrambled 
checkbox is selected. 

• 8B Descrambled Data - This option is applicable only for an SSIC setup. Select this option if you are expecting 
scrambled data on the sublink and want the U4431A module to descramble the acquired data. On selecting this option, 
the module will, however, descramble the acquired data only if the Data on link is scrambled checkbox is selected.

Protocol Data Capture - The U4431A module can capture both protocol level and raw signal level data simultaneously. The protocol data capture allows you to view 
the protocol level data in the Protocol viewer, providing an insight into packet trace and packet debug.
The Protocol Data Capture group box contains the following fields to enable and set the protocol data capture setting for a sublink.

UniPro Data
(Applicable only for a UniPro setup)

You can choose to enable or disable the decoding and extraction of the UniPro protocol level data for the applicable 
sublink. You can instruct the U4431A module to decode and extract the UniPro protocol level data by selecting the Enable 
checkbox displayed with the UniPro Data field. If this checkbox is not selected, the UniPro protocol level data is not 
available for viewing in the Protocol Viewer tool of the Keysight Logic and Protocol Analyzer application.
This field is displayed only when you install the UniPro specific license for the U4431A module.

UFS Data
(Applicable only for a UFS setup)

You can choose to enable or disable the decoding and extraction of the UFS protocol level data for the applicable sublink. 
You can instruct the U4431A module to decode and extract the UFS protocol level data by selecting the Enable checkbox 
displayed with the UFS Data field. If this checkbox is not selected, the UFS protocol level data is not available for viewing in 
the Protocol Viewer tool of the Keysight Logic and Protocol Analyzer application.
This field is displayed only when you install the UniPro+UFS license for the U4431A module.

CSI-3 Data 
(Applicable only for a CSI-3 setup)

You can choose to enable or disable the decoding and extraction of the CSI-3 protocol level data for the applicable sublink. 
You can instruct the U4431A module to decode and extract the CSI-3 protocol level data by selecting the Enable checkbox 
displayed with the CSI-3 Data field. If this checkbox is not selected, the CSI-3 protocol level data is not available for 
viewing in the Protocol Viewer tool of the Keysight Logic and Protocol Analyzer application.
This field is displayed only when you install the UniPro+CSI-3 license for the U4431A
module.

SSIC Data
(Applicable only for an SSIC setup)

You can choose to enable or disable the decoding and extraction of the SSIC protocol level data for the applicable sublink. 
You can instruct the U4431A module to decode and extract the SSIC protocol level data by selecting the Enable checkbox 
displayed with the SSIC Data field. If this checkbox is not selected, the SSIC protocol level data is not available for viewing 
in the Protocol Viewer tool of the Keysight Logic and Protocol Analyzer application.
This field is displayed only when you install the SSIC license for the U4431A module.

MPCIe Data
(Applicable only for MPCIe setup)

You can choose to enable or disable the decoding and extraction of the MPCIe protocol level data for the applicable 
sublink. You can instruct the U4431A module to decode and extract the MPCIe protocol level data by selecting the Enable 
checkbox displayed with the MPCIe Data field. If this checkbox is not selected, the MPCIe protocol level data is not 
available for viewing in the Protocol Viewer tool of the Keysight Logic and Protocol Analyzer application.
This field is displayed only when you install the MPCIe license for the U4431A module.

Depth You can divide the total memory depth that is licensed and available for the U4431A module between the configured 
sublink(s) of the link. For each sublink, you further divide the allocated memory between the protocol level data acquisition 
and raw signal level data acquisition (if enabled). 
From the Depth listbox, select the memory depth that you want to allocate to the acquisition of the protocol level data for 
the sublink. This listbox is disabled if you deselect the Enable checkboxes displayed in the Protocol Data Capture section. 
You can allocate a value ranging from 64 KB to 4 GB as the protocol data capture memory depth. 

Field Description
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After you have configured the capture settings, save the settings in a Logic Analyzer configuration 
(.ala) file. To do this, click File > Save, select a location and name for the configuration file, select 
Standard Configuration (.ala) from the Save as type listbox and then click Save. 

Sublink Configuration

Initial or current burst mode Allows you to select the burst mode that you want the U4431A module to initially use for the sublink during the process of 
syncing to the DUT's link configurations. Once initially set, you can later use this listbox to dynamically change the burst 
mode of the sublink as and when you need. For such dynamic changes to take effect, you also need to click the Sync 
Analyzer to Link Configuration button after setting the burst mode. 
In this listbox, by default, you get options to set:
• HS Gear 1 or PVM Gear 1 to 7 for a UniPro/UFS/CSI-3 sublink. 
• HS Gear 1 or PVM Gear 1 for SSIC and MPCIe sublinks.
The HS Gear 2 and 3 are licensed options and are displayed only when you install the appropriate license.
If you select a PVM Gear, then the minimum and maximum range of bit rates defined for that PVM gear in the specifications 
are applicable for the sublink.
If you select an HS Gear, then the data rate defined for that gear in the selected HS Rate series is applicable for the sublink.

Initial or current link width Allows you to select the link width that you want the U4431A module to initially use for the sublink during the process of 
syncing to the DUT's link configurations. Once initially set, you can later use this listbox to dynamically change the link 
width of the sublink as and when you need. For such dynamic changes to take effect, you also need to click the Sync 
Analyzer to Link Configuration button after setting the link width. 
In this listbox, by default, you get the option to set x1 as the link width for a sublink. The x2 to x4 are licensed options and 
are displayed only when you install the appropriate license. 
Notes
• The link width options displayed in this listbox also depend on the link width capabilities that you defined in the 

Sublink Wid th field in the Connection Setup tab. For instance, if you set the link width capabilities of a sublink as x2 in 
the Connection Setup tab, then only x1 and x2 options are displayed in the Initial or Current link width listbox. 

• For SSIC and MPCIe, only x1 is displayed as the link width option in case you select the PWM Gear 1 burst mode.

Initial or current data is scrambled
(Applicable only for a UniPro setup)

This checkbox is displayed only when you select the 1.6 option from the UniPro Spec Version listbox for a UniPro setup. 
This checkbox allows you to instruct the U4431A module on whether or not the data on the sublink is scrambled initially 
during the process of syncing to the DUT's link configurations. Once initially set, you can later use this checkbox to 
dynamically instruct the module on scrambled data on the sublink. For such dynamic changes to take effect, you also need 
to click the Sync Analyzer to Link Configuration button after setting the scrambling. 
When this checkbox is selected, the U4431A module enables descrambling for the scrambled data on the link.

Link Synchronization

Sync Analyzer to Link Configuration Click this button to synchronize the U4431A analyzer module to the currently set link configurations such as current link 
width and current link speed. 
On clicking this button, the current status of the sublink(s) in terms of their synchronization to current link configurations is 
displayed.
This option is particularly useful when you dynamically changed the sublink configurations using the Initial or current burst 
mode or Initial or current link width listboxes and want to synchronize the U4431A module to these changes. 

Sync Status Displays the current status of the U4431A sublink(s) in the context of its synchronization to the currently set link 
configurations.
A sublink can have one of the following link synchronization status:
• In Sync - Indicates that the sublink is in sync to the current link configurations.
• Off - Indicates that the sublink is not connected/active.
• Syncing - Indicates that the U4431A sublink is currently in the process of syncing to the current link configurations. If 

it is taking too long to sync, it may indicate that the U4431A module is not able to sync to the currently set link 
configurations. In such a situation, you may want to check if the link configurations that you are trying to set are 
matching the DUT’s configurations/capabilities. 

The Sync Status is updated:
• when you click the Sync Analyzer to Link Configuration button.
• when you change one of the settings in the Setup dialog box that impacts the link configuration and then click Apply or 

OK. 
• or automatically when there is a change in the probed link configurations and you have instructed the U4431A module 

to automatically track and sync to such changes.

Field Description
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Setting up Triggers

Trigger - Overview

You can trigger the U4431A module to start storing the captured data in its memory when the 
specified trigger condition is met. 

Using triggers, you can isolate events of interest in traffic. You can use triggers to detect errors at 
each layer of the protocol. You can set triggers for:

• Specific UniPro/UFS/SSIC/CSI-3/MPCIe packet types (based on the protocol license(s) you have 
installed)

• Physical layer triggers - Currently Crc, disparity, and symbol errors are supported. 

• Occurrence counter

• Global counter

• Timer

You can set a Simple or an Advanced trigger. 

• Simple trigger - A simple trigger allows you to quickly set up a trigger without getting involved 
into setting up multi-level sequenced steps for the trigger. In this type of trigger, you can include 
one or more trigger events whose occurrence causes the module to trigger the storage of the 
captured data. 

• Advanced trigger - An advanced trigger allows you to set up a complex multi-level sequenced 
trigger. In an advanced trigger, you can include multiple steps. In each step, you can define one 
or more trigger events and the action that should be performed with the occurrence of that event.

Trigger Settings

Based on the type of trigger (Simple or Advanced) that you are setting up, a trigger setup may be 
comprised of a trigger position, type, mode, store qualification, condition(s), and action. All these 
components of a trigger are set up using the fields displayed in the Trigger dialog box. 

You access the Trigger Dialog box by selecting Setup>Trigger.... from the Keysight Logic and Protocol 
Analyzer GUI’s menubar. 
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The following table has descriptions of all the fields available in this dialog box for setting up a simple 
or an advanced trigger. (See “Triggering Based on Packet Types, “To Set up a Simple Trigger, and “To 
Set up an Advanced Trigger for more information.)

Field Description

Link tabs The top of the Trigger dialog box allows you to add tabs that let you set up separate triggers for different MIPI M-PHY links. 
You can add tabs using the  icon and then apply these tabs to different links that are set up in the Connection Setup 
tab of the Setup dialog box.

Applies to Displays the MIPI M-PHY links that are set up in the Connection Setup tab of the Setup dialog box. Selecting one ore more 
links from the Applies to drop-down listbox applies the trigger settings in the current tab page to the data captured on the 
selected links.

Trigger Position Defines the trigger position within the acquisition memory of the U4431A module. The selected trigger position on the 
slider sets the pre and post trigger memory ratio. By default, the available acquisition memory is equally divided between 
the pre and post trigger memory. 

Favorite Triggers Displays a drop-down menu for:
• opening a previously saved trigger setup.
• saving the currently configured trigger setup in a Trigger Setup (.trg) file. 
• viewing and accessing a list of recently accessed trigger setup files.
Note: The favorite trigger setups referred in this drop-down menu are different from the favorites list that appear in the 
left-side events pane. In the left pane, the list of favorites refer to the favorite trigger events that you added, edited, and 
saved to the favorites list using the Event Editor dialog. 

Clear Clears the current trigger settings that you configured in the current tab and restores the default settings. 

For setting up a Simple Trigger - The following fields are applicable for a simple trigger.

Simple Trigger Select the Simple Trigger radio button. Selecting this radio button displays the fields relevant for setting a simple trigger in 
the Trigger dialog box. These fields are described below.

List of events In the left pane of the Trigger dialog box, an expandable list of events is displayed based on the protocol family (M-PHY, 
UniPro, or UFS) currently active for the U4431A module. The events in this list are organized based on categories such as:
• Types of packet - Displayed on the basis of the protocol license(s) you have installed.
• Physical Layer triggers - The transmission of an erroneous packet, for instance, with Crc, symbol, or disparity error sets 

the trigger.
• Arming - The U4431A module can receive triggers from another module installed in the AXIe chassis or another device 

with which it is connected via the Trigger in Connector on the AXIe chassis. 
You can select one or more of these events to act as trigger condition(s). 

Trigger Mode • Select the Trigger on Packets or Ordered Sets radio button to ensure that the U4431A module is triggered on the 
occurrence of the trigger event(s) included in the Select the Trigger(s) to use section.

• Select the Trigger when Stop button pressed radio button to ensure that the U4431A module is triggered to store the 
captured data when you click the Stop button to stop the data capture. On selecting this option, the trigger events are 
not applicable. Therefore, the Select the Trigger(s) to use section is disabled.

Select the Trigger(s) to use • Trigger on any of these events - You can drag events from the list of events displayed in the left pane and drop these 
events in this section. The U4431A module is triggered on the occurrence of any of the events included in this section.

• While ignoring any of these events - You can drag events from the list of events displayed in the left pane and drop 
these events in this section. The U4431A module is not triggered on the occurrence of any of the events included in this 
section.

To edit events included in the above-mentioned sections, click the underlined event name. This displays the Event Editor 
dialog box to let you edit the event properties or add the event to the list of favorite events.
To remove events from the above-mentioned sections, click the "X" displayed to the left of the event name.
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To Set up a Simple Trigger

1 In the Keysight Logic and Protocol Analyzer GUI’s Overview window, click the M-PHY module and 
select Setup>Trigger.... from the drop-down menu. Alternatively, click the  icon displayed for 
the M-PHY module.

The Trigger dialog box is displayed.

2 From the Applies to listbox, select the MIPI M-PHY link(s) to which you want to apply the trigger 
settings. 

3 If required, use the Trigger Position slider to change the default trigger position (50%) for the 
allocation of pre and post trigger memory. 

4 Select the Simple Trigger radio button. All simple trigger related fields are then displayed.

5 Select the Trigger Mode. On selecting the Trigger on Packets or Ordered Sets radio button, the Select 
the Trigger(s) to use section is displayed in which you can add trigger events. For the Trigger when 
Stop button is pressed option, trigger events are not applicable. Therefore, you cannot add any 
trigger events on selecting this option.

6 Drag and drop the desired trigger event(s) from the event list in the left pane to the Trigger on any 
of these events section on the right. 

7 To change an added trigger event’s properties, click that event’s underlined name in the Trigger 
on any of these events section.

8 To delete an added trigger event from the Trigger on any of these events section, click the “X” to the 
left of the event name.

9 From the event list in the left pane, drag the required events that you want to exclude and drop 
these in the While ignoring any of these events section.

10 Click Apply.

11 To save the currently configured trigger setup in a Trigger Setup (.trg) file, click the Favorite 
Triggers button and then select the Save option from the displayed drop-down menu. 

12 Click OK.

For setting up an Ad vanced Trigger- The following fields are applicable for an advanced trigger.

Advanced Trigger Select the Ad vanced Trigger radio button. Selecting this radio button displays the fields relevant for setting an advanced 
trigger in the Trigger dialog box. These fields are described below.

List of events In the left pane of the Trigger dialog box, an expandable list of events is displayed based on the protocol family (M-PHY, 
UniPro, or UFS) currently active for the U4431A module. The events in this list are organized based on categories such as:
• Type of packet - Displayed on the basis of the protocol license(s) you have installed.
• Physical Layer triggers - The transmission of an erroneous packet, for instance, with Crc, symbol, or disparity error sets 

the trigger.
• Timers, counters, and flags - Sets trigger on a timeout or the expiry of a counter. The U4431A module can also receive 

triggers from another module installed in the AXIe chassis or another device with which it is connected via the Trigger 
in Connector on the AXIe chassis. The Arm In from event is used in such a situation.

• Comment - Allows you to add comments to your advanced trigger setup.
You can select one or more of these events to act as trigger condition(s). 

Select the Trigger(s) to use By default, this section displays a single step with an ‘If - then’ specification for the trigger condition and subsequent 
action. If required, you can add more steps (maximum eight) in this section to set up a complex multi-level sequenced 
trigger. 
This section has the following fields:
• The Step button allows you to add or delete steps from the sequence. 
• The If/Else if buttons let you insert additional “If” clauses in the same step or delete an additional "if" clause from the 

step.
• To add multiple conditions / actions for a step, drag the required event from the list of events in the left pane and drop 

it to the step box. 
• The event chevron buttons let you insert, delete, or logically group (or negate) events.
• The action chevron buttons let you insert or delete actions.

Field Description
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Trigger Example

The following trigger setup aims at triggering the U4431A module on the transmission of any 
UniPro/UFS packet with Crc, symbol, or disparity error. 

To Set up an Advanced Trigger

1 In the Keysight Logic and Protocol Analyzer GUI’s Overview window, click the M-PHY module and 
select Setup>Trigger.... from the drop-down menu. Alternatively, click the  icon displayed for 
the M-PHY module.

The Trigger dialog box is displayed.

2 From the Applies to listbox, select the MIPI M-PHY link(s) to which you want to apply the trigger 
settings. 

3 If required, use the Trigger Position slider to change the default trigger position (50%) for the 
allocation of pre and post trigger memory. 

4 Select the Ad vanced Trigger radio button. All advanced trigger related fields are then displayed.
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5 As per your specific requirements:

a Edit the default step (Step 1) to select the trigger condition and action in the “If-Then” clause.

b Add more “If-Then” clauses to a step by clicking the If/Else If button in the step.

c Add more than one And/Or condition to an “If” clause of a step by clicking the  button for 

events. You can also negate a condition by selecting the “Insert Not at beginning of row” 

option from the  drop-down menu.

d Add more than one action to “Then” clause of a step by clicking the  button for actions. 

e Add more steps before or after a step by clicking a Step button.

6 Click Apply.

7 To save the currently configured trigger setup in a Trigger Setup (.trg) file, click the Favorite 
Triggers button and then select the Save option from the displayed drop-down menu. 

8 Click OK.

Trigger Example 1

The following trigger setup aims at triggering the U4431A module on the transmission of a 
preempted AFC0 UniPro packet at HS Gear 1 speed.
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Trigger Example 2

The following trigger setup aims at triggering the U4431A module on the transmission of a MPCIe 
packet at HS Gear 1 speed.

Triggering Based on Packet Types

You can configure the U4431A module to trigger on any or specific packet types. The packet types 
displayed in the simple and advanced trigger dialogs depend on the license(s) that you have 
installed. For instance, if you have the SSIC license installed, the SSIC-specific packet types are 
displayed. In case you have the UniPro and UFS license installed, the packet types for both UniPro as 
well as UFS are displayed.

NOTE
In case of MPCIe, setting a trigger on Start of Burst packet would ensure that 
the U4431 module is triggered on the transmission of Start of Burst as well as 
TS1 with SOB packets. Similarly, during the Search process if you search for any 
Start of Burst packets the search results would display even TS1 with SOB 
packets also.
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In a simple trigger

To trigger on “any packet” of the applicable protocol

Protocols Description

For UniPro Drag and drop the Any frame option from the 
UniPro Packet Types list in the left pane of 
the Trigger dialog.

For UFS Drag and drop the Any Packet option from the 
UFS Packet Types list in the left pane of the 
Trigger dialog.
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For SSIC Drag and drop the Any Packet option from the 
left pane of the Trigger dialog.

For CSI-3 Drag and drop the Any Packet option from the 
CSI-3 1.0 list in the left pane of the Trigger 
dialog.

For MPCIe Drag and drop the Anything option from left 
pane of the Trigger dialog.

Protocols Description
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To trigger on specific packet(s) of the applicable protocol

Protocol Description

For UniPro Drag and drop specific packet type(s) from 
the UniPro Packet Types list in the left pane 
of the Trigger dialog.

For UFS Drag and drop specific packet type(s) from 
the UFS Packet Types list in the left pane of 
the Trigger dialog.
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For SSIC Drag and drop specific packet type(s) from 
the left pane of the Trigger dialog.

For CSI-3 Drag and drop specific packet type(s) from 
the CSI-3 1.0 list in the left pane of the 
Trigger dialog.

For MPCIe Drag and drop specific packet type(s) from 
the left pane of the Trigger dialog.

Protocol Description
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In an advanced trigger

If you have the UniPro and UFS license, by default, a step added in an advanced trigger has the Any 
Frame option selected as the packet type. Any Frame, in this case represents any UniPro frame. 

In an advanced trigger step, if you want to configure a trigger on a specific UniPro frame or a specific 
UFS packet, simply drag and drop that frame/packet from the UniPro Packet Types/ UFS Packet Types 
lists in the left to the Any Frame option in the step. 

For SSIC, by default, a step added in an advanced trigger has Any packet selected as the packet type. 
Any packet, in this case represents any SSIC packet. If you want to trigger on a specific SSIC packet, 
you can drag and drop any SSIC packet from the left to the Any Packet option in the step.

For MPCIe, by default, a step added in an advanced trigger has Anything selected as the packet type. 
Anything, in this case represents any MPCIe packet. If you want to trigger on a specific MPCIe 
packet, you can drag and drop any MPCIe packet from the left to the Anything option in the step.
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If you have the UniPro/CSI-3 license, by default, a step added in an advanced trigger has Any frame 
selected as the packet type. Any Frame in this case represents any UniPro frame. If you want to 
trigger on a specific UniPro frame or a specific CSI-3 packet, simply drag and drop that frame/packet 
from the UniPro Packet Types/ CSI-3 lists in the left to the Any Frame option in the step.
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Starting and Stopping the Data Capture

Once the capture setup and trigger setup are ready, you can start capturing the M-PHY data.

To start the data capture, choose Run/Stop>Run from the Logic and Protocol Analyzer GUI’s menubar. 
Alternatively, click the  icon from the toolbar.

For more information, see the Running/Stopping Measurements topic in the Logic and Protocol 
Analyzer Online Help.

On starting data capture, the Status section at the bottom of the Logic and Protocol Analyzer GUI is 
updated to reflect the current status of the data capture procedure. 

The status moves from the Processing, Running, Waiting, and finally to Filling Memory state. 

To stop the data capture, click the  icon from the toolbar.

Capture Status Description

Processing The module is processing the data capture settings to initiate data capture.

Running The U4431A module is now in the Running state to capture M-PHY data.

Waiting The U4431A module is waiting for the trigger condition to meet to start data capture.

Filling Memory The trigger condition is met. The U4431A module is now triggered to start storing the captured data in 
its memory.
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This chapter provides information on how to view and analyze the captured M-PHY data for testing 
and debugging purposes using various viewers available in the Keysight Logic and Protocol Analyzer 
GUI.
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Overview

After you have captured M-PHY data using the U4431A module, you can view and analyze this data 
in the Keysight Logic and Protocol Analyzer GUI in the following two modes:

• Online - In the Online mode, the U4431A hardware is still connected and needed for viewing the 
captured data.

• Offline - For the Offline mode, you can save the captured data and configurations in a Logic 
Analyzer configuration file (.ala extension). You can later load this file in the Logic and Protocol 
Analyzer GUI to view and analyze data offline (without the U4431A module connected).

You can also export the captured data to CSV format files for offline viewing and analysis in 
applications other than the Logic and Protocol Analyzer GUI. 

For viewing the captured data in online or offline mode, various viewers are available in the Logic and 
Protocol Analyzer GUI. Each viewer has its own set of features for the presentation of captured data 
and is useful for specific situations. 

In the above screen, a Protocol Viewer and a Waveform Viewer are already added on starting a new 
session. A Listing viewer can be added manually.

The topics that follow describe how to use each of the available viewers for viewing and analyzing 
captured data. 

Viewer Usage Notes

Protocol Viewer To view protocol level packet data. Packet details 
are organized and viewable in different forms using 
different views available in Protocol Viewer

An instance of Protocol Viewer is automatically 
added and available in the Logic and Protocol 
Analyzer GUI when you create a new session of the 
U4431A module. 

Waveform Viewer To view both packet as well as raw signal data. An instance of Waveform Viewer is automatically 
added and available in the Logic and Protocol 
Analyzer GUI when you create a new session of the 
U4431A module. 

Listing To view raw signal level data If needed, you can add instance(s) of this viewer to 
the U4431A module by selecting New Window > 
Listing option in the Overview pane.

NOTE
The information about viewers in the following topics is specific to viewing and 
analyzing M-PHY data. To get general information about a viewer, its fields, or 
how to use it, refer to the topics in Reference > Windows section of the Logic 
and Protocol Analyzer Online Help. 
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Viewing M-PHY Packet Data Using the Protocol Viewer Display

The Protocol Viewer window provides various ways of viewing the captured M-PHY packet data. You 
can view summarized as well as detailed packet information at the same time within the upper and 
lower panes in this window. 

The upper pane of the Protocol Viewer displays a summarized list of captured M-PHY packets. The 
Protocol Viewer window is customized for the protocol family being decoded. For an M-PHY packet, 
it displays the M-PHY related decoded fields. In the following screen, the captured packet details 
specific to the UniPro protocol are displayed. 

NOTE
The information about the Protocol Viewer in this topic is specific to viewing and analyzing 
M-PHY packets. To get general information about the Protocol viewer, its fields, or how to 
use it, refer to the following topics in the Logic and Protocol Analyzer Online Help.

- Reference > Windows > Protocol Viewer Display Window 

- Analyzing the Captured Data > Analyzing Packet Data



5 Viewing and Analyzing Captured Data

50 Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide

Viewing Packet Data Specific to a Protocol

The U4431A module supports acquisition and decoding of the M-PHY, UniPro, UFS, SSIC, MPCIe, 
and CSI-3 protocols depending on which licenses you have installed. From the captured data, if 
required, you can view packet data specific to a U4431A supported protocol in the Protocol Viewer.

The Show listbox at the top in the Protocol Viewer displays the currently active licensed protocol 
options.

Selecting a protocol option from this listbox displays the captured data specific to only that protocol 
in the Protocol Viewer window. In the following screen, selecting the UFS protocol from the Show 
listbox displays the UFS specific captured data.
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Viewing Preempted Data

If you enabled preemption support for the U4431A module in the Analyzer Setup tab, you can view 
the captured frames that have been preempted by the module in the Protocol Viewer. If the 
preemption support is not enabled for the module, then for all the captured frames, the Preempting 
field is set to No to indicate that the frames have not been preempted. 

The preemption support is not applicable for SSIC and MPCIe setups.

The following screen displays a sample preempted frame with the Preempting field set to Yes to 
indicate that the frame has been preempted. 
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Identifying HS and PWM Data Transmissions

From the captured trace, you can identify the transmission in HS or PWM modes. The Gear column in 
the upper pane of the Protocol Viewer displays the burst mode and gear applicable for each packet 
in the captured trace. 



Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide 53

Viewing and Analyzing Captured Data 5

Viewing the Decoded Payload for a Packet

The Payload tab displays the decoded payload for the packet currently selected in the upper pane of 
the Protocol Viewer. 

The following screen displays the payload of a UniPro TC0 Data Frame.
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For CSI-3 image packets, the Payload tab displays the image’s pixel bytes data. The payload of an 
RGB format CSI-3 image packet is shown below.
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Changing Decode Settings for CSI-3 RAW Image Payload Data

For CSI-3 RAW image formats, the Payload tab also provides the Change Image Decode Settings 
button. By default, RGB presets are used for decoding the payload of CSI-3 RAW image formats. 
However, you can use the Change Image Decode Settings button to select different decode settings for 
the image payload data. Clicking this button displays the Raw Image Decode Settings dialog box.

For RAW formats, a number of preset options such as RGB, YMC, CMY, and Bayer decoding are 
available in the Raw Image Decode Settings dialog box. Based on the decode settings that you select 
in this dialog box, the image’s payload data is recalculated in the Payload tab. The changed settings 
are also applicable while extracting an image in the Image View tab.
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Viewing the Byte-wise Transmission of M-PHY Data

The Bytes tab in the lower pane of the Protocol Viewer provides a byte-wise view of the header and 
payload data of a packet. 

The bytes data in this tab is spread across rows to display the bytes data for header followed by the 
bytes data for payload (if applicable).

When you select a packet listed in the upper pane of Protocol Viewer, its raw data spread across 
bytes used for its transmission is displayed in the Bytes tab. 

NOTE
The data displayed in the Bytes tab does not represent the lane-wise view of bytes. This tab 
does not show the bytes spread across the lanes on which the bytes were transmitted. 

If you want to view the lane-wise transmission of raw data, you use the Waveform Viewer 
display. In this Viewer, you can see the raw data spread across the lanes used for its 
transmission. For this data to be acquired and displayed in Waveform Viewer, ensure that the 
Raw Data checkbox is selected in the Analyzer Setup dialog box prior to data acquisition. To 
know more, refer to the topic “Viewing the Lane-wise Transmission of Raw Data" on page 65.
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In the following figure, the data of a DATA_OUT UFS packet spread across the bytes used for its 
transmission is displayed. The red and blue highlights in this screen indicate the packet's header and 
payload data respectively. 

NOTE
You can toggle the visibility of the Bytes tab using the Toggle Byte Pane Visibility  
toolbar button displayed in the Protocol Viewer toolbar.



5 Viewing and Analyzing Captured Data

58 Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide

Viewing the Captured M-PHY Traffic Statistics

The Traffic Overview tab in the lower pane of the Protocol Viewer provides an overview of the M-PHY 
traffic listed in the upper pane. It provides a count of various types of captured M-PHY packets 
categorized on the basis of the type of packet. It also displays the count of M-PHY packet errors. 

To view M-PHY traffic statistics

1 Click the Traffic Overview tab.

2 In the Data Range group box, specify the range of data (from the upper pane) for which you want 
to compute and display traffic statistics. You can also select markers set in the upper pane for 
defining the data range.

3 Select the Include Errors checkbox if you want a count of errored packets to be included and 
displayed in the traffic statistics. 

4 Click Compute.

Traffic statistics are displayed for the selected data range. The left pane lists the packet types for 
the applicable protocol. Selecting a packet type from this list displays the total number of 
packets in the data range for that packet type. 

5 Use the Navigation section in the Traffic Statistics tab to navigate through the packets of a 
particular type in the upper pane. 

a Select a packet type from the right pane of Traffic Statistics.

b In the Navigation section text field, specify the packet occurrence to which you want to 
navigate in the upper pane. 

c Click Go. 

The specified packet occurrence is highlighted in the upper pane. 

NOTE
The last packet type “Errors” listed in the left pane displays the count for the 
errored packets categorized on the basis of errors types. This error count is 
displayed only if you selected the Include Errors checkbox before computing 
traffic statistics.
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Extracting Images from the Packet Data

You can use the Image View tab in the lower pane of the Protocol Viewer to display images 
constructed from the captured packet data. The Image View tab lists all the “Start of Frame” 
locations for images found in the captured data range specified by you. An image can be constructed 
from a selected “Start of Frame”.

All data formats in the CSI-3 specifications are supported for image construction in the Image View 
tab.

To extract an image

1 Click the Image View tab.

2 In the Data Range fields, select the range of the captured data from which the Start of Frame 
locations are to be displayed.

3 From the Display Time as section, you can choose to display the Start of Frame locations with their 
absolute time or the time relative to their previous frames. The default selection is Absolute.

4 Click Find.

All the “Start of Frame” locations from the captured data as per the data range specified by you 
are listed in the Image View tab.

5 Select a start of frame from the displayed list and click the Show Image button to get an image 
constructed from the selected start of frame. 

If you have the appropriate license, the image is constructed and displayed in the Extracted Image 
dialog box. The constructed image’s attributes such as width, height, format, and decoding 
options are also displayed. 

A test image constructed from the start of frame 0 (sample number 0) is displayed in the 
following screen. 

NOTE
The Image View tab is available in the lower pane of the Protocol Viewer window only if the 
following two prerequisites are met

- the CSI-3+UniPro license is installed for the U4431A module.

- CSI-3 is selected as the protocol in the Show listbox at the top of the Protocol Viewer. For 
other protocols, the Image View is not applicable.
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Saving the Extracted Image 

Once the extracted image is displayed in the Extracted Image dialog box, the following two options 
are available for saving this image:

• Save Binary - This button is displayed only if the extracted image is in a RAW format. Using this 
button, you can save the image’s pixel bytes in a binary (.bin) file. This allows you to save the raw 
image payload data that was originally captured by the U4431A module. This raw image payload 
data excludes any modifications that are made as a result of the color information calculation and 
decoding the image. 

• Save Image - This button is available for all image formats. It allows you to save the decoded image 
as a .bmp file. For an image with a RAW format, this button allows you to save the modified image 
that resulted from the color information calculations and decoding.

NOTE
In the Extracted Image dialog box, you can use the  buttons to construct 
and display an image from the first, next, previous or last Start of Image Frame locations 
currently listed in the Image View tab.

The Extracted Image dialog box also provides you four background patterns  
for the displayed image. 
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Changing the Decoding Options for the Extracted Image

By default, an image is decoded and displayed in the Extracted Image dialog box as per the image 
decoding options set in the Payload tab. If required, you can change the decoding options for the 
displayed image to redisplay it as per the changed decoding options. 

To change the decoding options of an extracted image

1 Click the Change the decoding options button displayed in the Extracted Image dialog box. 

The Raw Image Decode Settings dialog box is displayed. 

2 Change the decoding options as needed. To know more, refer to the topic “Changing Decode 
Settings for CSI-3 RAW Image Payload Data" on page 55.

Exporting the list of “Start of Frames” locations to a CSV File

You can also export the list of Start of Frames locations to a CSV file by clicking the Export l ist to CSV 
button. On clicking this button, a CSV file is generated. The list of “start of frames” displayed for the 
specified range of captured data is exported to this CSV file. The timestamps of the start of frames 
list exported to this CSV file are absolute regardless of the time stetting (Absolute or Relative to 
previous frame) that you have selected in the Image View tab. 

The following screen displays a sample CSV file with the exported start of frames list. 

NOTE
If you want to export the protocol data displayed in the upper pane of the Protocol Viewer to a CSV 
file, you can use the Export to CSV toolbar button displayed at the top of Protocol Viewer. 

The output CSV file has data matching the fields and their sequencing currently displayed in the 
upper pane of the Protocol Viewer. 
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Viewing Packet and Raw Signal Data using the Waveform Viewer

You can view the captured M-PHY data (both packet data as well as raw signal data) as a digital 
waveform in the Waveform Viewer. The captured bus/signal data is displayed in a time based 
waveform as transmitted on the link. The Waveform view is useful in situations where you want to get 
an overview of the M-PHY link transitions. 

Understanding Waveform Viewer Display for M-PHY Data

A waveform display primarily displays the acquired M-PHY data as follows.

• The first row in the waveform area is the captured M-PHY/UniPro/SSIC packet name. In case of 
MPCIe, each packet is displayed in the form of a horizontal colored bar. Each packet is identified 
by a separate color across the timeline and you can correlate the same color both in Waveform 
and Protocol viewer.

• The second row in the waveform area is the applicable UFS/CSI-3 packet name if the UFS/CSI-3 
data is captured. For a bidirectional link, this is followed by the captured M-PHY/UniPro/SSIC 
packet name in the other direction. 

• After the packet name(s), various link configuration settings as detected across the timeline are 
displayed such as:

• the current state of link

• burst mode

• rate series

• link width

• whether or not data is deskewed (1 represents deskewed and 0 represents skewed)

• whether or not data is scrambled (1 represents descrambling is enabled for scrambled data 
and 0 represents descrambling is disabled)

• whether or not there is a symbol error (1 represents a symbol error in the data and 0 represents 
no symbol error)

• whether or not there is a disparity error (1 represents a disparity error in the data and 0 
represents no disparity error)

• The link configurations are followed by the captured lane-wise signal data values for a sublink. 
This includes symbol, 8b encoded, and 10b encoded data. For a bidirectional setup, the data for 
one sublink is followed by the data for the other sublink. 

If needed, you can hide a specific information about the captured data from the waveform display by 
right-clicking on the information row on the left and selecting Delete Row. 

NOTE
The information about the Waveform Viewer in this topic is specific to viewing and analyzing 
M-PHY data. To get general information about the Waveform Viewer, its display, or how to use 
it, refer to the following topics in the Logic and Protocol Analyzer Online Help.

- Reference > Windows > Waveform Display Window 

- Analyzing the Captured Data > Analyzing Waveform Data

NOTE
The display of raw data in the Waveform Viewer depends on whether or not you enabled the 
Raw data capture feature in the Analyzer Setup tab prior to data acquisition.
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In the following screen, the data for the DATA IN UFS packet (TC0 Data Frame UniPro packet) is 
displayed in the Waveform Viewer. 
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You can correlate the data displayed in the waveform with the relevant packet(s) in the Protocol 
Viewer. The following screen displays the correlated packet data for the signal data displayed in the 
above screen.
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Viewing the Lane-wise Transmission of Raw Data

In the Waveform Viewer, you can view raw data organized as per the data lanes on which it was 
transmitted. 

For instance, in the following screen, the raw data for SSIC packets is displayed across the four lanes 
D0 to D3 used for its transmission. In this example, each row of data in the highlighted section of the 
Waveform Viewer represents the data transmitted on the lane indicated through the row's label. 

The lane-wise display of data can be skewed or deskewed based on the Raw Data Capture Mode that 
you selected in the Analyzer Setup tab prior to data acquisition.

NOTE
The display of raw data for each lane in the Waveform Viewer depends on whether or not you 
enabled the Raw data capture feature in the Analyzer Setup tab prior to data acquisition.
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Viewing Deskewed and Descrambled Data

Deskewing the Acquired Data

By default, the U4431A moduledeskews the acquired data because the default selection for the Raw 
Data Capture Mode is 8b Desrambled and Deskewed Data in case of SSIC and MPCIe and 8b Deskewed Data 
in case of UniPRo/UFS/CSI-3. 

To enable deskew for the data to be acquired

1 Access the Analyzer Setup tab of the Setup dialog box.

2 From the Raw Data Capture Mode listbox, 

• select the 8b Deskewed Data option for UniPro/UFS/CSI-3. 

• select the 8b Desrambled and Deskewed Data option for SSIC and MPCIe.

To view deskewed data

1 Display the Waveform Viewer window.

2 Look for the DESKEWED row in the Waveform Viewer. Notice that, in the following example, the 
DESKEWED value is displayed as 1 indicating that the deskewing is enabled. The deskewed data 
at the start of a burst across the three lanes (D0, D1, and D2) is also highlighted in this example. 
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Descrambling the Scrambled Data

Descrambling is applicable only for SSIC and MPCIe setups. By default, the U4431A module 
descrambles the scrambled data on the link because by default, the Data on l ink is scrambled checkbox 
is selected in the Analyzer Setup tab. 

To enable descrambling for the scrambled data

1 Access the Analyzer Setup tab of the Setup dialog box.

2 Ensure that the following two options are selected:

• the Data on l ink is scrambled checkbox is selected

• the 8b Desrambled and Deskewed Data option or the 8b Descrambled Data option is selected from 
the Raw Data Capture Mode listbox.

To view descrambled data

1 Display Waveform Viewer.

2 Look for the SCRAMBLED row in the Waveform Viewer. Notice that, in the following example, the 
SCRAMBLED value is displayed as 1 indicating that the data on the link is scrambled for which 
descrambling has been enabled. The descrambled data across lanes is also highlighted in red in 
this example. 
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Tracking and Viewing Link States in Captured Data

In the Waveform Viewer, you can track and view the changes in the link's state of the acquired data. 
The LINK_STATE row in the Waveform Viewer displays the link's transitions from one state to another 
across the timeline of the acquired data. 

In case of a bidirectional acquisition, the state of Transmit and Receive sublinks is displayed 
separately. 

In the following screen, the row displaying the link state is highlighted.
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Viewing Time Synchronized Protocol Data in Display Windows

For analysis or debugging, you may want to view the captured data in a display window along with its 
related protocol/signal data in another window such that the displays are time synchronized for ease 
of mapping and viewing related data. One such situation can be viewing UniPro protocol data in a 
Protocol Viewer and the related UFS protocol data in another Protocol Viewer. Or, viewing SSIC 
protocol data in a Protocol Viewer and its related signal data in a Waveform Viewer. 

In such situations, you can use the Lockstep windows feature to ensure that when a Protocol Viewer 
window is scrolled, other lock stepped windows are automatically scrolled as well, such that the 
same time is centered in each lock stepped display window. This allows you to easily map and view 
correlated data in multiple display windows. 

You can lockstep a Protocol Viewer window with display windows such as another Protocol Viewer, 
Waveform, Listing, or Compare. 

Some examples of using the lockstep feature with the data captured using U4431A are described 
below.

To lockstep UniPro protocol data with UFS protocol data

1 In the Overview window, ensure that you have added two instances of Protocol Viewers, one for 
the UniPro data and another for UFS data.

2 Ensure that each of the Protocol Viewer instance shows the data specific to the protocol for 
which it was created. Use the Show button in Protocol Viewer to show data specific to a protocol.

3 From the Protocol Viewer toolbar, click the  Lockstep Windows toolbar button.
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In the Lockstep Windows dialog, select the other instance of Protocol Viewer with which you want to 
synchronize scrolling and specify any time offset from this window. For instance, from the UFS 
Protocol Viewer instance, select the UniPro Protocol Viewer instance.

4 Click OK to close the Lockstep Windows dialog.

Once the windows are lockstepped, scrolling or moving to a specific marker in the lockstepped 
window automatically scrolls the other window to the appropriate location. 
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Similarly, you can lockstep a Protocol Viewer window with a Waveform Viewer window to ensure that 
when you scroll in Waveform Viewer window, protocol data in Protocol Viewer is scrolled. The 
following screen shows a synchronized display of SSIC data in Protocol Viewer and Waveform Viewer 
windows using Lockstep feature.
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The U4431A Analyzer module can decode and display transactions from the captured MPCIe data. 
This chapter describes how you can compute and view these decoded transactions.
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Transaction Decoding - Overview

The Transaction Decode tab in the Protocol Viewer window allows you to compute and view 
transactions decoded from the captured MPCIe traffic. The decoding and display of transactions is 
done as per the relevant storage protocol specifications to help you easily correlate the decoded 
data to the protocol specifications and evaluate DUT’s compliance to these specifications.

Types of Protocols Supported

In this release, decoding of MPCIe transactions is supported.

Transaction Decode Tab

You use the Transaction Decode tab displayed in the lower pane of the Protocol Viewer to compute 
and view decoded transactions.

This tab consist of two panes. The left pane displays a list of transactions. The right pane displays the 
number of occurrences of these transactions.
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Configuring and Computing Decoded Transactions

Before you Start

• You should have purchased and installed the U4431 Transaction Decoder license for computing 
decoded transactions.

On purchasing the license, you receive an entitlement certificate. Follow the instructions in this 
certificate to install the license.

• Ensure that the data in the required direction(s) is already captured and available in the Logic and 
Protocol Analyzer GUI for transaction decoding. You may save the captured data in a Logic 
Analyzer configuration (.ala) file and access this data offline for transaction decoding.

• It is recommended that you capture the device’s complete boot process data so that the required 
device setup details are available for decoding transactions accurately.

Computing Transactions from the Captured Data

1 Click the Transaction Decode tab in the Protocol Viewer window.

2 In the Data Range groupbox, specify the start and end points of the captured MPCIe data for which 
you want to compute decoded transactions. Only the specified range of data is analyzed to 
compute transactions. Following options are available for setting the data range.

• Beginning and End of data - This data range selection ensures that transactions are computed for 
the entire trace.

• Trigger - Selecting Trigger in the data range ensures that transactions are computed from the 
point where the U4431 module’s trigger condition was met.

• Markers - Selecting markers in the data range ensures that transactions are computed for the 
specific portion of MPCIe traffic defined by markers. Refer to “Defining Markers for Setting the 
Computation Range" on page 76 to know more.

3 Click the Compute button displayed with the Data Range fields. The Compute This and Compute All 
are the two options available with this button. Compute All allows you to compute traffic overview 
statistics (see page 58), decoded transactions, and offline performance summary (see 
page 92)for the captured packets by a single click of this button. Compute This allows you to 
compute only the decoded transactions from the captured packets. When you click Compute, 
then also only the decoded transactions are computed. 

Transactions are computed and displayed for the specified data range.



6 Computing and Viewing Decoded Transactions

76 Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide

Defining Markers for Setting the Computation Range

If the captured MPCIe traffic is too large and you want to view decoded transactions from a specific 
portion of this traffic, then you can limit the computation range by defining start and end markers in 
the MPCIe traffic. 

To define markers

1 From the upper pane of the Protocol Viewer, right-click the row in the captured MPCIe traffic that 
should act as the starting point for transaction decode. 

2 Select Place Marker from the displayed context menu and then select an existing marker or click 
New Marker to define a new marker at this point.

Once markers are defined, these are available for selection in the Data Range group box of the 
Transaction Decode tab.

Defining / Verifying the Device Setup

While computing decoded transactions, the Logic and Protocol Analyzer software automatically 
discovers the required device details such as device ID, type, and base address from the captured 
data. You can view this device related data in the Transaction Decode Setup dialog box. 

NOTE
You need to recompute the decoded transaction results if you want to change:

- the data range for which transactions are to be displayed.

- the storage protocol for which transactions are to be displayed.

- the device setup such as base address, size, or the number of queues.
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You use the Transaction Decode Setup dialog box to define/modify/verify the information about the 
device being tested. The types of information displayed in this dialog box differ based on the storage 
protocol decode applicable for the device.

To verify/modify device details

1 Click Setup in the Transaction Decode tab of the Protocol Viewer.

The Transaction Decode Setup dialog box is displayed with the autodiscovered device details from 
the captured MPCIe data. 

2 Modify Device ID and Base Address, if needed.

3 You can also add a new device details by clicking Add Device and then selecting the appropriate 
device type applicable for the DUT. 

4 To delete the setup details of an existing device, click Remove Device.

5 Double-click the device row to view/edit its details. Alternatively, select the device row and click 
Edit Details...

NOTE
At times, the required device details are not available in the captured data and therefore 
cannot be autodiscovered from the captured data. In such situations, it becomes mandatory 
for you to specify these details. To avoid such a situation, you can ensure that device details 
are available by capturing the device’s complete boot process.

It is recommended that you verify and modify device details (if needed) for accurate 
transaction decode computation.
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The Device Setup dialog box is displayed. The tabs and fields in this dialog box differ based on the 
storage protocol decode applicable for the device.

Saving the Device Setup Details

You can save the device, its queues, and namespace details (specified using the Transaction Decode 
Setup dialog box) in a Transaction decode (.tdprop) file. Once saved, you can open this file later in 
the Transaction Decode Setup dialog box to quickly access and set up the device details for a 
transaction decode computation.

To save device details

1 Click Setup in the Transaction Decode tab of the Protocol Viewer.

The Transaction Decode Setup dialog box is displayed. Modify the device details as needed.

2 Click File > Save As...

3 Specify a name for the Transaction Decode setup file and click Save.

To open a previously saved setup file for transaction computation

1 Click Setup in the Transaction Decode tab.

The Transaction Decode Setup dialog box is displayed.

2 Click File > Open.

3 In the Open dialog box, select the Transaction decode (.tdprop) file that contains the device setup 
details.

4 Click Open.

You can edit a saved .tdprop file by opening it in an XML Editor or the Transaction Decode Setup 
dialog box. 

Viewing the Configuration Space of a DUT

While computing decoded transactions, the Logic and Protocol Analyzer software automatically 
discovers and reads details from various MPCIe configuration registers in the DUT’s configuration 
space. It displays register values for DUT’s capabilities such as PCI, PCIe, MPCIe, Power 
Management, MSI, Virtual Channel, and Secondary PCIe Extended capabilities.

To view the configuration space of a DUT

1 Compute decoded transactions in the Transaction Decode tab.

2 Click the Config Space Summary button displayed in the top panel of the Transaction Decode tab.

The configuration space summary of the DUT is displayed.
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Viewing the Attribute Summary of a DUT

While computing decoded transactions, if the Logic and Protocol Analyzer software detects that the 
captured data includes PWM G1 data when RRAP packets are transmitted, it displays a button 
named Attribute Summary button in the Transaction Decode tab. You can use this button to display 
details related the attributes discovered from the decode of RRAP packets found in the captured 
data.

To view the attribute space summary of a DUT

1 Compute decoded transactions in the Transaction Decode tab.

2 Click the Attribute Summary button displayed in the top panel of the Transaction Decode tab.

The attribute space summary of the DUT is displayed.

NOTE
This button is not displayed if the captured data does not include RRAP packets.
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Configuring Timestamps Displayed in the Computed Transactions

Each computed transaction has a timestamp displayed for it. You can configure:

• where you want the timestamp field to be located for the computed transactions.

• the base to be used for the calculation of timestamps of transactions.

To configure timestamp settings

1 Right-click the Timestamp field displayed for a computed transaction.

2 Select Timestamp Base from the context-menu.

3 From the displayed submenu, you can select:
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• Absolute - Timestamp for a transaction is calculated on the basis of the absolute time of the 
first MPCIe packet applicable for that transaction. This is the default selection.

• Relative - Timestamp for a transaction is calculated relative to the time of the first packet 
applicable for the previous transaction in the list.

• Relative Marker - Timestamps are calculated relative to the marker that you select from the 
displayed submenu.

Changing the timestamp base recalculates the displayed timestamps based on the selected 
base.

4 Right-click the Timestamp field displayed for a computed transaction and then select Timestamp 
Location from the context-menu.

5 By default, timestamps are displayed in the front of transactions data. If required, you can move 
the display of timestamps to the back of transactions data. 

Saving the Computed Transaction Data

Once you computed the transaction data, you can save it in a logic analyzer .ala configuration file. 
The transaction data is saved along with the captured MPCIe traffic, device setup details, and any 
other configurations that you made in the Protocol Viewer window. 

To save the computed transaction data

1 Click File > Save as.

2 In the Save As dialog box, specify the name of the file.

3 Ensure that the Standard Configuration (*.ala) option is selected as the file type and All Data and Setup 
is selected in the File Options group box.

4 Click Save.

To access and view previously saved transaction data

1 Click File > Open.

2 In the Open dialog box, navigate to the Standard Configuration (*.ala) file in which you saved the 
transaction data.

3 Click Open.

Clearing the Computed Transaction Data

You can clear the computed transaction data displayed in the Transaction Decode tab. 

1 Right-click a transaction displayed in the Transaction Decode tab. 

2 Click Clear Transaction Data... from the right-click context menu.

NOTE
You do not need the Transaction Decoder software license to view the saved transaction data. 
However, if you want to recompute transactions from the saved MPCIe trace, then you need 
the Transaction Decoder software license.
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3 Click Yes to confirm.

The computed transactions display is cleared.

If the transactions data was previously saved in an .ala file, then reloading the .ala file redisplays 
the transactions data after it has been cleared. If the transactions data was not previously saved, 
you can specify the data range and then click Compute again to redisplay the transactions data.
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Interpreting and Navigating Through the Transaction Decode Results

Transactions are decoded and computed from a set of captured MPCIe packets that contain the 
storage protocol information associated with that transaction.

Decoded transactions are displayed in the Transaction Decode tab in an order based on the 
timestamp of the first packet associated with a transaction. One or many MPCIe packets may be 
associated with a transaction.

Transaction Details Pane

In the left pane of the Transaction Decode tab, transactions with their details are displayed. In this 
pane, a transaction is uniquely identified by a Transaction ID.

The details displayed for transactions vary based on their type and the applicable storage protocol. 
Moving the mouse pointer to a field of a transaction presents a tool tip with information about that 
field.

A color coding scheme is used to clearly indicate transactions of different types. Errored transactions 
are displayed in red.

NOTE
If you are displaying data captured from multiple U4431A modules in a single Protocol Viewer 
instance, then transactions from these multiple modules will be interleaved based on the 
timestamp of the first packet in the transaction. 

To display transactions for each module separately, you can add a Protocol Viewer instance to 
each module in the Overview pane of the Logic and Protocol Analyzer GUI. 
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Transaction Overview Pane

The right pane of the Transaction Decode tab displays statistics for the computed transactions. This 
pane lists the transaction types applicable for the computed transaction data and the number of 
events/occurrences for each transaction type in the computed data.

In this pane, you can organize the number of transaction occurrences/events on the basis of the 
organization types described in the following table.

Organized by Description

Direction Transaction occurrences are organized on the basis of the Uplink and Downlink directions in the captured data.
If the captured data is unidirectional, then this view displays occurrences for one direction only.

Configuration 
Space

Selecting this option displays the number of occurrences of only MPCIe config space transactions organized on 
the basis of reads and writes to MPCIe configuration registers in the DUT’s configuration space.
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Navigating Through Transactions

You can easily navigate through the occurrences of a particular type of transaction in the computed 
transaction data. 

1 From the Transaction Overview pane on the lower-right, select a transaction type whose 
occurrences you want to navigate and view.

The navigation bar in the Transaction Decode tab now displays the total number of occurrences 
found for the selected transaction type.

2 To view the first occurrence of that transaction type in the computed data, click  button in 

the navigation bar. Click  to go to the last occurrence of the selected transaction type.

3 To sequentially move through the occurrences of a transaction type, use the  buttons in 

the navigation bar.

4 To go to a specific occurrence of a transaction type, specify the event/occurrence number in the 
text box displayed in the navigation bar and click Go.

You can also double-click a particular occurrence number in the right pane to navigate to the first 
transaction mapped to that occurrence number. For instance, in the following screen, the first 
occurrence of a Config Read transaction to the MPCIe Capabilities Register is highlighted on 
double-clicking its occurrence number in the right pane. 
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Navigating Between Transactions and their Associated Packets

From a transaction listed in the Transaction Decode tab, you can quickly navigate to the MPCIe 
packet(s) exchanged for that particular transaction. To accomplish this, you need to double-click a 
transaction in the Transaction Decode tab. Doing so, highlights the packet exchanged as the first 
packet for that transaction in the upper pane of the Protocol Viewer. You can also use the Synchronize 

 button in the Transaction Decode tab to synchronize the display of packets data with the 
selected transaction.

In the following screen, double-clicking the transaction for Config Read to the Capabilities Register 
highlights the memory read packet for this transaction.

Navigating to a specific packet of a transaction

A transaction may have multiple packets associated with it. For such transactions, you can directly 
navigate to any packet of the transaction. To do this,

1 Right-click a transaction.

2 Select Go To Packet > Packet List. 

A list of packets applicable for that transaction are displayed in a sequential order. 

NOTE
You can also quickly navigate from a MPCIe packet displayed in the upper pane to its 
applicable transaction in the Transaction Decode tab. To accomplish this, you select the 
packet and then click the Synchronize button displayed in the Transaction Decode tab. 
This synchronizes the display of transactions with the selected packet.



Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide 87

Computing and Viewing Decoded Transactions 6

3 Select a packet from this list. The packet that you selected gets highlighted in the upper pane of 
the Protocol Viewer.

Visualizing a Transaction Set (Super Transaction)

At times, you may want to visualize a decoded transaction as a super transaction with all its related 
transactions forming a complete set. This provides a visual sequential flow of transactions that were 
related to a particular transaction.

To visualize a transaction set

1 Right-click a decoded transaction.

2 Select Visual ize Transaction... from the context menu.

For instance, in the following screen, the MPCIe transaction has been visualized as a complete set of 
transactions.
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In the above screen, the transaction set for the MPCIe Write transaction is displayed: It begins with 
the Write command followed by a response to this Write command. 

For each of these related transactions in a set, you can view:

• the associated raw payload in the lower pane.

• the applicable PCIe packet(s) in the right pane. 

MPCIe Packets applicable for a Transaction Set 

In the right pane of the Visualize Transaction dialog box, by default, MPCIe packets are listed as per 
the Nested (Time Ordered) option. This means packets are listed in a time based sequence with the 
completion packets nested within the applicable Read packets. If required, you can change this 
display to:

• list the packets in a logical sequence instead of time based sequence - Logical (Not Time 
Ordered) option.

• list the packets without nesting the completions within the read packets - Packets (Time 
Ordered) option.

For each of the listed packets, the following time related fields are displayed:

• Timestamp - This field is relative to the timestamp of the first packet displayed for the transaction 
set. (The first packet timestamp is taken as 0s.).

• Delta Time - This field displays the difference between the timestamp of the currently selected 
packet and the previous packet in the list of packets for the transaction set. 

You can enable or disable the display of Completions and Acks packets from the packets list in the 
right pane using the Show Completions and Acks checkboxes respectively.

NOTE
Clicking a super transaction displays the combined payload for the complete set of 
transactions.
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In the Protocol Viewer window, you can generate and view the performance summary from the 
MPCIe and SSIC trace that you captured using the U4431A Analyzer module. This chapter describes 
how you can compute and view offline performance summary from the captured MPCIe/SSIC data.
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Offline Performance Summary - Overview

The Performance Overview tab in the Protocol Viewer window allows you to perform post processing 
on the captured MPCIe/SSIC traffic to generate an offline performance summary of bus utilization. 
This tab presents statistics for various performance parameters in tabular as well as charts form.

In this tab, you define the range of captured data for which performance summary is to be generated. 
The software decodes transactions from this specified range of data and then computes performance 
statistics and charts from the decoded transactions. The specified range of trace data is sampled and 
statistics is computed from these samples to generate charts for each performance parameter.

Performance statistics are displayed separately for upstream and downstream link directions.

Performance Overview Tab

You use the Performance Overview tab displayed in the lower pane of the Protocol Viewer to 
compute and view performance summary.

This tab displays the performance data in the following two panes.

NOTE
You do not need connectivity to the U4431A hardware module to generate 
performance summary from a captured trace.

Pane Description

Performance Statistics pane This is the left pane that displays a list of categories and the performance parameters for each of the categories for which 
statistics will be generated and displayed. For each of the parameters that you select, statistics are displayed based on the 
link directions (upstream as well as downstream). 

Performance Charts pane This is the right pane and displays a performance chart for selected performance parameters listed under the category.
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The Overlay View - At a Glance

The information in the Performance Overview tab is presented using the Overlay view. The Overlay 
view allows you to select the series that you want to be displayed in the chart area. You can select 
the series by clicking the required performance parameter check box listed under Statistics 
tree/table on the left. This view displays graphs for the selected series in a single chart with a black 
background. It displays the Band Chart area where you can view the MSI Write, Msg Assert_INT and 
Msg Deassert_INT and error packets occurrence plotted in the chart. It also displays multiple Y-axis 
which you select in the Setup dialog box. To know more about how to select and interpret multiple 
Y-axis, see “Showing/Hiding multiple Y-axis" on page 94. Following screen displays the Overlay view 
after you select and compute a range: 

In the above screen, graphs for the Update_FC_P series (represented by dotted lines) in both 
directions are displayed. The blue dotted line represents the graph for Update_FC_P series in 
upstream, whereas, the red dotted line represents the graph for Update_FC_P series in the 
downstream direction.

NOTE
If the Performance Overview tab is not visible, click the  button displayed at the top of 
the Protocol Viewer window.
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Configuring and Computing Offline Performance Summary

Before you Start

• Ensure that the data in the required direction(s) is already captured and available in the Logic and 
Protocol Analyzer GUI for performance summary computation. You may save the captured data in 
a Logic Analyzer configuration (.ala) file and access this data offline for performance summary 
computation.

Computing Offline Performance Summary

1 Click the Performance Overview tab in the Protocol Viewer window.

2 In the Data Range groupbox, specify the start and end points of the captured MPCIe/SSIC data for 
which you want to compute performance summary. Only the specified range of data is analyzed 
to compute performance. Following options are available for setting this data range. 

• Beginning and End of data - This data range selection ensures that performance summary is 
computed for the entire trace. 

• Begin Extent and End Extent - This data range selection ensures that performance summary is 
computed only for the data that has been marked by extent markers. The software 
automatically places extent markers on the beginning and end of the current pan/zoom 
extents defined in charts. When you change the pan/zoom extents in charts, the extent 
markers are automatically moved to changed extents.

• Trigger - Selecting Trigger in the data range ensures that performance summary is computed 
from the point where the U4431 module’s trigger condition was met. 

• Markers - Selecting markers in the data range ensures that performance summary is computed 
for the specific portion of MPCIe traffic defined by markers. Refer to “Defining Markers for 
Setting the Computation Range" on page 93 to know more.

3 For generating performance statistics, only complete transactions from the captured trace are 
used. Select the Assume ACK checkbox to instruct the software to assume ACKs for the 
transactions in which only ACK is missing. Assuming ACKs, therefore ensures that the 
transactions with missing ACK are considered complete and used in performance summary 
computation. You may want to use this Assume ACK option in situations such as when you have 
filtered ACKs while data capture to make more memory available to TLPs.

4 For producing the performance statistics, transaction of only error free packets from the captured 
trace are taken into account. The packets containing error are ignored while generating the 
performance statistics. Select the Include Errors check-box to let the software include error 
packets and compute the performance statistics including these packets. Selecting Include 
Errors checkbox increases the computation time of Performance Overview. It creates a series that 
is displayed in the Band Chart with an element for each packet containing error in the list. 

5 Click the Compute button displayed with the Data Range fields. The Compute This and Compute All 
are the two options available with this button. Compute All allows you to compute traffic overview 
statistics, decoded transactions, and offline performance summary for the captured packets by a 
single click of this button. Compute This allows you to compute only offline performance statistics 
from the captured packets. When you click Compute, then also compute only offline performance 
statistics.
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On clicking Compute, first the transactions are decoded from the specified data range of MPCIe 
trace. Then, statistics and charts are computed from these decoded transactions and results are 
displayed. 

Defining Markers for Setting the Computation Range

If the captured MPCIe/SSIC traffic is too large and you want to view performance summary for a 
specific portion of this traffic, then you can limit the computation range by defining start and end 
markers in the traffic. 

To define markers

1 From the upper pane of the Protocol Viewer, right-click the row in the captured traffic that should 
act as the starting point for performance summary computation. 

2 Select Place Marker from the displayed context menu and then select an existing marker or click 
New Marker to define a new marker at this point.

Once markers are defined, these are available for selection in the Data Range group box of the 
Performance Overview tab.

Saving the Computed Performance Summary Data

Once you computed the performance summary data, you can save the performance configurations 
along with the captured traffic in a logic analyzer .ala configuration file. On saving, the settings such 
as zoom, pan, sample rate, markers, chart type, and chart order that you configured in the 
Performance Overview tab are also saved in the .ala file along with the trace data. Loading this .ala 
file retrieves these settings and computes and displays performance summary based on the saved 
settings.

To save the performance summary settings

1 Click File > Save as.

2 In the Save As dialog box, specify the name of the file.

3 Ensure that the Standard Configuration (*.ala) option is selected as the file type and All Data and Setup 
is selected in the File Options group box.

4 Click Save.

To access and view previously saved performance summary settings

1 Click File > Open.

2 In the Open dialog box, navigate to the Standard Configuration (*.ala) file in which you saved the 
data.

3 Click Open.

Defining Chart Settings

You can define settings for the overlay chart in the Setup... tab of the Settings section and change 
the appearance of the displayed chart. 

To access the Setup dialog box

Click the Setup... button under the Settings section. The Setup dialog box appears as shown below. 
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The setup details that you specify in this dialog box helps you change the way series and axes are 
displayed in the overlay graph. For example- you can change the graph display type and color of the 
displayed series or you can show or hide the Y-axis by selecting or de-selecting the respective Y-axis 
checkbox. 

The following is the list of tasks that you can do using the Setup dialog box: 

Showing/Hiding multiple Y-axis

Select or de-select the Y-axis checkbox to show or hide the Y-axis displayed in the chart.
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Specifying InitFC values

You can initially define the maximum flow control credit limits by entering InitFC values for posted, 
non-posted, and completion transactions in both directions (Upstream and Downstream). You can 
do this separately for Data and Header flow control Init values.

Click  button displayed with the InitFC P, InitFC NP, and InitFC Cpl fields to open the calculator 
and input values. Select the checkbox ‘Use these InitFC values’ to use the InitFC values defined by 
you when you are computing and interpreting offline performance summary. In case InitFC values are 
not defined or ‘Use these InitFC values’ field is not selected, the minimum and maximum credit levels 
for the captured trace is automatically computed and flow control mechanism works on the basis of 
those calculated values. The minimum and maximum credit levels varies from one trace to other 
depending upon the size of the trace.

NOTE
Showing or hiding a particular Y-axis does not affect how series are computed or 
displayed in the chart. 
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Specifying Min/Max value for MSI and MSI-X Address

You can specify the minimum and maximum values for the Message Signaled Interrupt (MSI/MSI-X) 
address in the MSI and MSI-X Address row for which you want Interrupt to be generated and plotted 
in the Band Chart. 

Selecting this checkbox will generate interrupts for the specified address which you can view in the 
Band Chart. 

Understanding Parameter Column 

The series which you select by clicking their respective check-box in the Statistics Tree/Table of the 
Performance Overview Tab is displayed here in the Parameter column of the Setup dialog box. The 
Parameter is the full name of the series and is comprised of the Direction (Up or Down), the Category 
name picked from the Performance Statistics tree/table, and the checked Series name. 

Changing the appearance of the graph

You can change the appearance of the graph representing the respective series listed in the 
Parameter column of the Setup dialog box. To do so, click the drop-down in the Type column and 
select the graph type you want to change with.

NOTE
InitFC values are applicable only for Flow Control performance statistics 
category. You can use InitFC values for posted, non-posted and completions 
transactions only when you are computing flow control credits. 
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Changing the color of the Graph Line

You can also change the color of the graph line by picking color of your choice from the color palette. 
To do so, click the Color drop-down to display the color combo box consisting of different colors, and 
select the color of your choice.

• Once all the settings are defined in the Setup dialog box, click the Close button to apply those 
settings and exit from the dialog box. 

• Click the Reset button to restore the last settings done previously when you opened the Setup 
dialog box. This resets the Axis, Types and Colors to their previous state. 

• Clicking the Cancel button allows you to exit from the dialog box without making any changes.
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Interpreting the Performance Summary Results

Performance Statistics panes

The Performance Statistics pane displays a hierarchical list in which various performance statistics are 
categorized in groups and sub-groups. 

Clicking a group or category in this pane displays the link-wise statistics for associated performance 
parameters. The following table briefly describes the performance statistics displayed for categories

.

Some important points while viewing and interpreting performance summary:

• A --.-- value displayed in a statistics tree/table for a performance parameter indicates that the 
packet(s) required to generate that statistics is not found in the trace. It signifies ‘no data’ received 
for generating the statistics. Consequently, the chart corresponding to such a performance 
parameter contains no data and is therefore not displayed in the charts pane. Such a chart gets 
displayed only when the required packets are found while computing performance summary to 
generate data for the chart.

Category Performance Statistics Displayed

Flow Control Tracks and computes the available flow control credits for a bidirectional data trace and helps in analyzing the flow of data. To 
know more refer to the topic “Flow Control.

Bus Statistics • Band wid th (GBits/s): Shows the number of non- idle symbol bits transferred per second.
• Data Throughput (MBytes/s): Shows the number of TLP payload bytes transferred per second.
• Payload Length (DWords): Shows the minimum, maximum, as well as average payload size for TLPs.
• TLP Count (TLPs/s): Shows the number of TLPs transferred per second.
• Link Efficiency (%): Shows the efficiency of the link. It is calculated as Symbol time for payload / (Symbol time for all DLLP + 

Symbol time for all TLP + Symbol time for OS).
• Link Util ization (%): Shows the percentage of non- idle symbols in total number of symbols transferred.
• TLP Util ization (%): Shows the percentage of TLP symbols in total number of symbols transferred.

Transaction Performance • Non- Posted Transactions: Shows the minimum, maximum, and average values of the following performance parameters for 
all non- posted transactions.
• Response Time (ns): It is same as the duration of the transaction.
• Latency (us): It is the time duration between the end of a request transaction and the arrival of its first completion.
• Throughput (MBytes/s): It is the length of complete data divided by the response time.

• Posted Transactions: Shows the minimum, maximum, and average values of the following performance parameters for all 
posted transactions.
• Response Time (ns): It is same as the duration of the transaction.
• Throughput (MBytes/s): It is the length of complete data divided by the response time.
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• For calculating the statistics for the Completion parameter, only Completions with Data packets 
are included. Any Completions without Data packets found in the trace are ignored for this 
parameter’s statistics calculations. 

For instance, in the following screen, the Completion with Data packets are used for calculating 
the minimum, maximum, and average payload size for Completions. In the absence of 
Completion with Data packets in the trace, the Completion statistics is shown --.--.
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• Some performance parameters are displayed in blue color. This indicates that the navigation to 
the associated MPCIe packet is applicable for that performance parameter. To know more, refer 
to “From the Performance Statistics pane" on page 109.

Charts pane

This pane displays charts for all the selected performance parameters listed in the statistics tree 
table.

Viewing Multiple Y-axis in the Chart Pane

The chart pane displays multiple Y-axis if you select multiple Y-axis checkbox in the Setup... dialog 
box. To know more, see “Showing/Hiding multiple Y-axis" on page 94.

Viewing Overlay Charts and defining Color code for graphs

The Chart pane displays Overlay chart for selected performance parameters listed in the categories 
pane. You can define different color codes to display the performance data for downstream and 
upstream directions in charts. To accomplish this, click the Setup... button under the Settings 
section. Then, click the Color drop-down to select the color from the color palette. To know more, 
refer “Changing the color of the Graph Line" on page 97.
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Viewing Band Chart

The lower section of the Chart pane displays the Band Chart. You can view MSI Write, Msg 
Assert_INT and Msg Deassert_INT and error packets in the Band chart area of the Chart pane.

Viewing X and Y axes values in a chart

Hovering the mouse over a chart location displays the applicable values of X-axis and Y-axis for that 
location.
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Flow Control

Flow Control computes and displays the available flow control credits from the data trace that has a 
bidirectional traffic. It presents flow control statistics and graphs and helps in analyzing the flow of 
data. Flow control credit level is determined by the Writes and Completions in one direction and the 
UpdateFC packets in the other direction. The data series created for the flow control charts contain a 
point for every packet that is a part of that series. This is in contrast to all other charts which 
represent a group of packets in a sample period. Flow control credit levels are represented by 
UpdateFC series. The performance parameters for the Flow Control are explained below: 

• UpdateFC_P (Bytes) - Shows the minimum, maximum, as well as average flow control credit levels 
for posted transactions.

• UpdateFC_NP (Bytes) - Shows the minimum, maximum, as well as average flow control credit levels 
for non-posted transactions.

• UpdateFC_Cpl (Bytes) - Shows the minimum, maximum, as well as average flow control credit levels 
for Completions data.

• Memory Read (Bytes) - Charts the size of Memory Read requests in each direction (X and Y axes). 

• Memory Write (Bytes) - Maps the size of Memory Write and MsgD packets in each direction. 

• Memory_CplD (Bytes) - Charts the size of Memory completion with data packets in each direction. 

• Inst. CplD and Inst. Write (Mbytes/s) - The instantaneous completion with data (Inst. CplD) and 
instantaneous write (Inst. Write) show Instantaneous Bandwidth in each direction. Instantaneous 
Bandwidth is defined as the number of data bytes (in MegaBytes) in the packet divided by the 
time (in seconds) since the end of the previous data carrying packet to the end time of the current 
data carrying packet. 

Each packet carrying data is represented by a point in these series.

• Interrupts- Shows the location in the graph where MSI Write, Msg Assert_INT and Msg 
Deassert_INT occurred. This is displayed in the Band chart area of the chart pane.

• Error Packet- Shows the location in the graph where packets with any error occurred. This is 
displayed in the Band chart only when the Include Errors checkbox is enabled under Data Range 
heading. 

Flow Control- Examples

The following examples elaborate the usage of Flow Control feature:

Example-1

The flow control charts represent the computed flow control credit level, which is meant for how 
many bytes the receiver is ready to receive. When the data is sent in a higher volume than the 
receiving capacity of the receiver, there will be a continuous slow movement of data from transmitter 
to receiver. This sometimes also leads to data loss. In such scenarios, you can use the Flow Control 
feature to display the credit limits of the data to be sent and the data received by the receiver. 

In this example, 4092B (1023 DW) packets of data are being sent in the downstream direction and 
the link partner is updating credits in increments of 4096B. In the following screen, a steep decline in 
the blue line clearly indicates the situation that FC credit is being updated at higher rate than the 
rate at which data is being posted. The blue line represents the computed UpdateFC_P regulating 
against the red line representing the corresponding Memory Write packets in the trace.
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The UpdateFC_P Flow Control credit level is reduced by Memory Write packets coming from the root 
occurred in the trace. As displayed in the above graph, the Maximum is near the beginning of the 
trace and the Flow Control credit level continuously drops down and reaches zero on the right side of 
the trace. 

This too many credits difference may indicate problem in the credit update behavior of the DUT. 

Example-2

In the following screen, when memory completion data (Memory CplD) is being sent, the 
UpdateFC_Cpl performance parameter computes and displays minimum, maximum, as well as 
average flow control credit levels for Completions data. The blue and orange Pyramid Up chart line 
represents Memory CplD and UpdateFC_Cpl respectively. The UpdateFC_Cpl credit starts from an 
initial counter value and keeps on updating its credit limit till all the packets are sent and received. 
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As displayed in the above graph, the UpdateFC_Cpl graph line keeps showing the credit fluctuation 
regulating against the corresponding Memory Completion packets coming from root that occurred in 
the trace. The drop in credit level shows how many packets are left to be transmitted and helps in 
regulating the flow of data packets. When all packets are transmitted and received, the FC level 
changes to zero counter value. It remains constant till any further credits are added into account. 
Once the FC level is incremented with some value, the same mechanism is repeated till all the 
packets are transmitted and received and FC level again comes to a zero value.

Example-3

In the start of the DMA buffer transfer, the link credits are quickly exhausted and reaches to zero 
counter value because the buffer transfer runs at a higher rate in comparison to the rest of the data 
transfer. The quick drop in credit level is caused by the chain of link buffering. In the start, the data 
write or completion capacity remains higher than the sink capacity but lower than the link capacity. 
The data transfer at higher rate only happens while the link buffering capacity can sustain it.
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Saving the Favorite Overlay Chart

In the Performance Overview tab, the Settings section has a Favorite Charts button which allows you 
to save your favorite charts and open the previously saved overlay charts.

The overlay chart is saved along with all the settings that you made to the graph displayed in the 
chart pane of MPCIe performance tab (such as selecting or deselecting various performance 
parameters in the Categories pane, zooming or panning the chart, making changes in the Setup 
dialog box etc.).

To save the Overlay Chart 

1 Click Favorite Charts button> Save as.

2 In the Save As dialog box, specify the name of the chart. Ensure that *.cfv (Chart Favorite) option 
is selected as the file type.

3 Click Save.

To view previously saved Overlay chart

1 Click Favorite Charts button> Open.

2 In the Open dialog box, navigate to the *.cfv file name by which you saved the Overlay chart.

3 Click Open.
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Navigating Through the Performance Summary Results

Navigating Through a Chart

By Using Pan option

To navigate through a chart horizontally, that is X-axis, click the Pan X-Axis button displayed at the 
top of the charts pane.

To navigate through a chart horizontally and vertically, that is both axis, click the Pan Both Axis button 
displayed at the top of the Charts pane. You can then drag the chart up, down, left, and right.

Navigating Between Performance Statistics and Associated MPCIe Data

By placing markers in charts

You can place markers in charts and use these markers to navigate to the MPCIe packet associated 
with the chart location at which you placed a marker. Markers placed in charts are correlated to 
markers displayed in the trace data in the upper pane of the Protocol Viewer.

This type of navigation is particularly useful when you notice a sudden variation in a chart and want 
to navigate to the exact trace position that corresponds to that chart location.

To place a marker in charts

1 Double-click the location in the chart at which you want to place a marker. A new marker is 
added to that chart location and the corresponding trace location in the upper pane (trace view).

Alternatively, right-click the chart location where you want to place a marker. Then select Place > 
New Marker or select an existing marker to place that marker at the current location.
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To navigate to a particular marker placed in charts

In situations when you have placed multiple markers in charts, you may want to navigate to a 
particular marker and its associated trace position in the upper pane. To do so, right-click anywhere 
in a chart, select Go To and then select the marker to which you want to navigate.

On doing so, the chart display moves to the point at which the selected marker is located. Also, the 
trace position corresponding to the selected marker is highlighted in the upper pane.

NOTE
If the markers are not displayed in charts, click the Show Markers button at the top of the 
charts pane.



7 Viewing Offline Performance Summary

108 Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide

By using Extent Markers 

When you pan/zoom a defined area in charts, Extent Markers are automatically placed at the 
beginning and end of this defined pan/zoom extent in charts. On changing the pan/zoom area, these 
markers are automatically moved. There may be situations when you zoom a specific area in charts 
and then want to navigate to the MPCIe data associated with the chart’s zoomed area in a Waveform 
Viewer or a Listing. To accomplish this, you can navigate using Extent Markers. 

To navigate using Extent markers:

1 Right-click anywhere in the zoomed area in a chart and select Go To.

2 Then select Begin Extent or End Extent to navigate to the data associated with the beginning or end 
of the zoomed area.

The applicable data is highlighted in the upper pane of Protocol Viewer as well as in Waveform and 
Listing viewers. 

NOTE
If the Extent Markers are not visible, then click the Extent Markers button at the top of the 
charts panes to display these markers in trace view as well as other viewers in Logic and 
Protocol Analyzer application.
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From the Performance Statistics pane

For some performance parameters such as Minimum and Maximum, it is possible to navigate directly 
to the MPCIe/SSIC packet that accounted for the generation of a particular statistical value of that 
performance parameter.

Such performance parameters for which navigation to the packet is applicable are displayed in blue 
color. 

In the following screen the “Message” parameter in the downstream direction has a Min of 1.0 and 
Max of 1024 displayed in blue color. Clicking these numbers, navigate you to MsgD packets with 
lengths of 1 and 1024 (DWords) that is accounted for the minimum and maximum value respectively 
in the upper pane.
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NOTE
The chart pane does not show the exact value of the data packets as displayed in 
the upper pane of the Protocol Viewer window. This is because the chart pane 
displays the graph of sampled series that represents an average value of all the 
packets transmitted during a particular micro second as defined in the sample 
rate field. 
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Customizing Charts

Changing the Sampling Rate and Re-sampling the Chart

Sampling is a process by which captured data trace is sampled on the basis of specified time period 
to create charts. The trace data is sampled to compute statistics from these samples for charts 
generation. This sampling is done as per the Sample Rate set for charts. By default, the sample rate 
is set to 10 microseconds. You can change this sample rate and can re-sample the data trace by 
specifying time slices. By re-sampling the data you can regenerate charts based on the changed 
sampling rate. 

To change the sample rate of charts

1 Access the Performance Overview tab.

2 Click the  button displayed with the Sample Rate field in the Charts pane on the right.

3 In the Time dialog box, specify the value and unit for the sample rate. The permissible range for 
sample rate is 1 us to 100 ms. 

4 Click OK.

To regenerate charts based on the new sample rate

1 Click the Re-Sample button displayed with the Sample Rate field at the top of the Charts pane.

When you capture a data trace and sample it at defined sample rate to generate charts, there may 
be repeated scenarios when no message packets are received during a particular slice of time while 
sampling the entire trace. Such scenarios are represented in the graph by plotting glyphs at zero 
entry. The glyphs plotted at zero, which you see in the chart, signifies no data packet received at that 
time. 

Changing the Chart Display

You can change how data is presented in a performance chart. To know, how to change the chart 
display, see “Changing the appearance of the graph" on page 96. 

By default, data is presented as Dash Line chart type. The following chart type options are available.

NOTE
Sampling is done on the basis of specified time period defined as per the sample 
rate. It is not applicable for Flow Control category because Flow Control 
statistics is not time dependent and is based on the flow control credits of the 
data transmitted and received, The series listed under the Flow Control category 
have packet granularity whereas sampling is significant for all other categories 
listed in the Statistics tree/table of the Performance Overview tab. 

NOTE
Message packet displaying a zero/hyphen value in the chart does not mean it 
has zero value, rather it means no relevant data received at that time.
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• Line - 

• Dash Line- 
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• Dot Line - 

• Triangle Up/Down - 
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• Pyramid Up/Down - 

• Perpendicular Up/Down- 
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• Dot/Circle - 

• Box/Square - 
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• Diamond/Filled Diamond - 

To change chart type for a performance chart

Click the drop-down in the Type column from the Setup... dialog box and select the type you want to 
change with.

The chart is displayed as per the changed chart type.

Showing/Hiding the Band Chart

You can show or hide the Band Chart displayed in the lower pane of the chart area.

To hide the Band Chart

Right-click anywhere in the chart location and then select Hide Band Chart.



Keysight U4431A MIPI M-PHY Protocol Analyzer User Guide 117

Viewing Offline Performance Summary 7

To show the Band Chart

Right-click anywhere in the chart location and then select Show Band Chart.

Viewing the Center of the Chart

If the captured traffic is too large and defined pan/zoom extent in the overlay chart is outsized, there 
may be situations when you want to view where the center of the chart’s zoomed area lies. You can 
do so by using Show Center check-box.

To view the center of the chart’s zoomed area, click the checkbox Show Center. Selecting this 
checkbox displays a white colored vertical dotted line at the center of the Overlay Chart. It makes the 
center of the chart apparent as displayed in the following screen:
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Zooming In/Out Charts 

You can zoom in or zoom out a defined area in the chart or the complete chart.

To zoom X-Axis for a defined area in the chart

1 Click the Zoom X-Axis option from the combo box displayed in the Pan and Zoom section of the 
charts pane to make it active. 

2 Move the mouse pointer to the chart location from which you want to begin zooming.

3 Left-click at this location and while keeping the left mouse button pressed, drag the mouse to the 
chart location till which you want to zoom the display. As you move the mouse, the zooming 
extent is defined in chart and highlighted with grey.

When you release the left mouse button, the defined X-axis area is zoomed for all the displayed 
charts. Following screen displays the chart before and after zooming in Overlay view:
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Similarly, you can zoom both X and Y axes of the defined area in the chart by selecting the Zoom Both 
Axes option from the combo box displayed in the Pan and Zoom section of the performance charts 
pane. 
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You can also zoom in or zoom out complete charts. To do this, use the following buttons in the Pan 
and Zoom section of the charts pane.

•  - Zoom In magnifies the center 50% of the chart to the full width of the chart.

•  - Zoom Out doubles the time displayed in the full width of the chart.

•  - Zoom Out Full displays the entire range of Computed data across the full width of the 
chart.

NOTE
The X-axis zoom applies to all the displayed charts where as the Y-axis zoom (in both axis 
zoom) applies only to the chart in which you define the area to zoom.

NOTE
You can undo and redo zooms by clicking the  and  buttons in the Pan and Zoom 
section of the charts pane.
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